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1 INTRODUCTION 
This document is intended as a guide to Project creation, and to assist in the editing of existing Project 
information. It summarises how to use some of the Utilities required to ensure successful Project configuration. 

Where references for more information in specific manuals occur read the specific help file or refer to 

 Start > All Programs > … > Online Books 

Note:  ‘…’ denotes the installation path. 

 

1.1 DOCUMENT CONTENTS 
This document primarily describes how to configure a Plant Solution (and its variants). These are projects that 
contain LIN instruments, configured using LINTools, the variant ‘with Operations’ just means there is an Operator 
view created using Wonderware products, and ‘Clone Network’ is the LIN network part of a Plant Solution that 
has been created by cloning the LIN instruments that are detected on a LIN network. Chapters 2 to 27 provide the 
necessary information to perform these configurations. 

A Modbus Data provider is a different type of project that does not contain LIN instruments and basically 
connects a 2500 (Modbus instrument) with the Wonderware front end. Chapter 28 describes how to configure a 
Modbus Data Provider. 

 

1.2 BUILD NOTES 
The ‘Build’ operation is used to update the Project database with information and changes in the Project. To 
update the Project database, it must be ensured that ALL Build operations are carried out on the LIN Network 
containing the changes, preferably using the following command: 

Project Organiser > Project > Full Project Build. 

This will make sure that any new Instrument is added to the Project database, that any removed Instrument 
(including all associated Tags) is deleted from the Project database and that any changes to an Instrument are 
updated in the Project database. 

If in doubt Build the entire Project to ensure all amendments are updated in the Project database. This is done 
automatically via Project Organiser, and LINtools Engineering Studio. 
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2 CREATING A NEW PROJECT FOLDER 
This creates all Editors, Configurators, Utilities, Wizards and Files required to create the Project and stores them in 
a hierarchical directory structure. 

1. Create a new Project folder by starting the new Project wizard. 

 Start > All Programs > … > New Project 

Note:   ‘…’ denotes the installation path. 

A New Project can also be created via the shortcut icon on the desktop or from within the LINtools Engineering 
Studio application.  

2. This initiates the New 
Project Wizard which 
offers the choice of 
Project Types depending 
on the installation and 
license. 

 Select the type of project 
required. 

Note:   For full 
instructions refer to 
the help information 
shown alongside each 
dialog. 

Once created, the Properties of the Project folder allow Project build option configuration. 

Project Description 
Empty Empty project folder, without a project database, allowing folders to be created as 

required. 
Clone Network Project folder replicated from an existing ‘Live’ plant or system. 
Plant Solution with Operations (InTouch) 

Distributed LIN instrument system with Wonderware InTouch Operations viewers. This 
creates a standalone (published) InTouch application. 

Plant Solution with Operations (ArchestrA) 
 Distributed LIN instrument system with Wonderware InTouch Operations viewers. This 

is a Managed InTouch application, and is edited using the ArchestrA IDE allowing the 
full range of ArchestrA symbols. The application can be Published at a later stage. 

Modbus I/O with Operations (InTouch) 
Serial Modbus or Modbus TCP connecting I/O instruments with a single Wonderware 
InTouch Operations viewer. This creates a standalone (published) InTouch application. 
See Chapter 28. 

Modbus I/O with operations (ArchestrA) 
 Serial Modbus or Modbus TCP connecting I/O instruments with a single Wonderware 

InTouch Operations viewer. This creates a managed InTouch application, and is edited 
using the ArchestrA IDE allowing the full range of ArchestrA symbols. The application 
can be published at a later stage. See Chapter 28. 

Plant Solution Distributed LIN instrument system, including Project database, with no auto-generated 
operator view. 

 



SYSTEM CONFIGURATION USER GUIDE 

HA028314  
Issue 8  Dec 17 Page 9 

3. Follow the instructions shown on each page of the wizard. If the selected Project Wizard includes 
Wonderware FactorySuite Intouch Software, the Intouch Application Name by default is the same as 
the Project Name. By default ALL Projects are located in the: 

 <Install Drive (generally C:)>:\EuroPS\… 

4. Press .  It may take a few minutes to create the entire Project folder. All files are copied to 
the Project. Once complete, the Project will be displayed in the Project Organiser environment. 

Notes:  For full instructions refer to the Project Organiser Help file. This describes the function of 
each item, and how to create and configure it. 

 

Note:  A default drop location for Tags, Target Drop area shown in the small area in the Tree view, 
can be defined and changed as required in Project Organiser. This is an item within Project Organiser 
that requires the attachment of many Tags from throughout the plant/system. 

 

 



SYSTEM CONFIGURATION USER GUIDE 

 HA028314 
Page 10 Issue 8  Dec 17 

3 CONFIGURING PROJECT PROPERTIES 
The Project folder properties are set up to define the Active Project (if not already configured using the New 
Project wizard), and the location of the Project Database locally on the Computer, and from a Network 
perspective, i.e. from another Computer or LIN Instrument using the Project Database in the plant/system. The 
Project folder properties to be configured are, 

Set As Active Project. This defines the Active Project instructing LINOPC/LINData/InTouch what Project 
database to use at runtime. 

NOTE:  When changing or setting the Active Project, LINOPC and all associated Clients (LINData, 
Alarm Provider, LINtools Engineering Studio and OPC SCOPE) must be shutdown. Once this has been 
done, LINOPC can be shut down using the Shutdown LINOPC command. 
 Start > … > Utilities > Shutdown LINOPC 

Master Computer  This defines the Computer operating as the Master in the plant/system used for 
Project development. 

Master Project Path This defines the local path to the Project Database. 
Master Project UNC Path 

This defines the network path to the Project Database. 
  

1. If the Project has been closed, open the new Project folder from 

  Start > All Programs > … > <New Project Name> 
where ‘…’ denotes the installation path. 

 Alternatively double click the shortcut icon displayed on the Computer desktop if created. 

Note:  Opening the Project using both means, creates separate related windows. 

WINDOWS EXPLORER VIEW 

Windows Explorer is the secondary method of configuring a Project if Project Organiser is available, but is the 
primary method when Project Organiser is not available, i.e. prior to version 4.2. 

A Windows Explorer view, accessed via the Project > Explore Project command, shows the Project data, the 
Folders pane displaying the Project folder that includes an InTouch Application of the same name, a History folder 
that stores files as an historic log, and a Networks folder containing any LIN network already configured from the 
LINOPC Control Applet and all the associated instruments. 

The main part of the Windows Explorer view shows the top-level folders and the installed Utilities. 

Note:  It is recommended that Project Organiser be used whenever available. 
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2. Select Properties. 

Project > Project Properties 

 

 

 

 

 

 

3. Select the Project page. 

4. Press the Set Active Project button. 

 

 

 

 

 

 

 

 

 

 

5. Select the Master Project page. 

Note:  These and additional parameters can also be 
edited in the relevant Computer Properties dialog. 

Ensure ALL fields correctly identify the selected Project. 

 Master Computer: This defines the Computer operating 
as the Master in the plant/system used for Project 
development. 

 Master Project Path: This defines the local path to the 
Project Database held on this Computer. 

 Master Project UNC Path:  This defines the network 
path to the Project Database held on this Computer. 

Note: The Master Project UNC Path is a network 
path and MUST be correctly configured for sharing 
and security. Ideally, it uses the same Project Name. 

6 Click OK to accept all changes made to the Project 
Properties and close the Properties box. 
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4 CONFIGURING THE INSTALLATION 
4.1 SHARED NETWORK PATH USING THE SYSTEM CHECKING TOOL 

Note:  Any computer to be used to operate the InTouch Application must be correctly configured 
and have appropriate compatible NT login User accounts stored locally. 
Use the System Checking Tool to edit these parameters (refer to the Project Organiser Help file for 
full instructions). 

1. Assuming that Project Organiser has remained 
open, launch the System Checking Tool by 
selecting the Tool > System Checking Tool 
command. 

2. The Shared Network path is automatically 
configured using the File Sharing option. 
Alternatively, by selecting each section in turn, 
and using the buttons displayed in the main part 
of the window, a default configuration is applied, 
which is sufficient for most Projects. 

Note:  Additional information, relating to the 
item selected in the left pane, is displayed 
below the main part of the window. 

DCOM Security can also be 
configured using this Tool. It 
automatically configures 
shared connections to LINOPC 
through Windows DCOM 
Service. 

If an imported Project was 
created using an earlier 
version, the Project Database 
may need to be updated. A 
button in the Project database 
update section initiates a 
wizard to upgrade the Project 
Database and Security 
Database to the version used 
by this installation. 
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4.1.1 Configuring the Shared Network Path using Windows Explorer 

As stated above, any computer that will run the InTouch Application MUST have a Shared network path for the 
Project database. 

1. Open Windows Explorer. 

2. Find and select the EuroPS directory. C:\EuroPS 

3. Select Properties. File > Properties 

 

 

 

 

4. Select the Sharing tab. 

5. Click the Shared As radio button to 
activate Shared operation. 

6. Press the Permissions button and 
make sure it is set to Full Permissions. 

Note:  A Project folder must be 
created and renamed at 
C:\EuroPS\MyProject on each client 
computer, using  
File > New > Folder and then 
File > Rename 
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5 CREATING LIN NETWORK FOLDERS 
LIN Network folders are created to store all the files and subfolders related to each network in the Project, and to 
provide easy access to the Online Monitoring and Download operations. 

Note:  A Build operation is done automatically from Project Organiser after a Network folder has 
been created or deleted to update the Project database. Build is NOT required when only the 
properties of the Network folder are being edited. 

1. Assuming that Project 
Organiser has remained 
open, select the 
Networks folder. 

2. Create a LIN Network 
folder by launching the 
New Network wizard. 
File > New Network 

 Alternatively, the wizard 
can be launched by 

pressing .  Each 
LIN network 
corresponds to a physical network in the system. 

3. This initiates the New Network Wizard. After an appropriate Network name has been entered, it offers 
the choice of Network Types. 

Note:  It is recommended that to simplify the identification of a Network, <Network 
Type>_<Network number> convention should be used, e.g. ELIN_01. 

 A New Network folder can also be created from within the LINtools Engineering Studio application in 
an existing Project or a New Project. 

Network Type Definition 
LIN Local Instrument Network. Supports peer to peer communications between 

Computers and instruments with LIN database files. 
MODBUS  Supports communications between T800/ T940 instruments and the 2500I/O system 

with single Wonderware InTouch Operations viewer. 
PROFIBUS PROFIBUS supports communications between T800 or T940 Instruments and the 2500 

I/O system. 
EI-BISYNCH EI-BISYNCH supports communications with PC3000 devices including 2000 series 

Controllers, PC3000 and PC300. 

4. Follow the instructions shown on each page of the wizard. 

5. Click on the ‘Finish’ button. This automatically launches the Build process which may a few minutes to 
create the Network Type folder. 
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5.1 CLONE A NETWORK 
LIN Network folders, including all instrument and further sub-networks and instruments can be easily created in 
Project Organiser from an existing ‘Live’ Plant/system network using the Clone Network wizard. 

Assuming that Project Organiser has remained open, select the Networks folder: 

1. Clone an existing 
LIN Network by 
launching the Clone 
Network wizard. 

2. Launched by 

pressing . 

3. Each LIN network 
corresponds to a 
physical network in 
the system. 

 

 

Note:  Individual Instrument folders can also be copied from an existing ‘Live’ plant/system using the 
Clone Network Wizard. 
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5.2 ONLINE MONITORING AND DOWNLOAD USING NETWORK FOLDERS 
The Properties of each LIN Network folder allows a LINOPC port to be selected and configured to be used to 
Download, Start, Stop and Monitor the LIN configurations in that network. 

This setting is required only if you wish to allow Downloading, Starting and Stopping of instruments in this 
Network folder from the context menu and File menu of each instrument. In addition, the LIST.UJD file in each 
instrument folder can be configured using LINtools Engineering Studio to specify which files are to be 
downloaded. 

If this is not configured, the context menu and File menu for the LIN instrument folders will have the Download, 
Start and Stop options disabled and greyed out. These operations can still be carried out using the Network 
Explorer, but the user must know which files are relevant for the respective instruments. 

This can be reconfigured at any time from here on. 

Note:  A Build operation is not required if only the Properties of the Network folder are being 
edited. However, LINOPC may have to be restarted if the changes are not recognised by Project 
Organiser. 

5.2.1 Changing a LIN OPC port 

1. Select the LIN Network folder icon to reveal the 
context menu. 

2. Select Properties. This shows the LIN Network 
tab. 

 

 

 

 

 

 

 

3. Change the Online Port and Remote 
Machine fields if required. (This is normally 
configured using the ‘New Network’ 
wizard.) 

Note:  Use the Ports Setup button to 
Add, Edit or Delete Port Names. This 
opens the LINOPC control applet, that 

can also be launched by pressing . 

4. Close the Properties window. 

Note:  A build operation is required only 
if the Properties of the Network folder 
are to be edited. However, LINOPC may 
have to be restarted if the changes are 
not recognised by Project Organiser. 
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6 CREATE LIN INSTRUMENT FOLDERS (INSTRUMENTS) 
The LIN Instrument folders are created to store ALL the LIN Instrument configuration files related to each LIN 
Instrument in the associated Network. The file menu for LIN Instrument folders also includes the control of 
Online Monitoring and Download operations with the inclusion of the Download, Start and Stop options. If these 
are greyed out, they are unavailable because the Network folder above the instruments has not been configured 
for this purpose. 

The Properties of each LIN Instrument folder allow you to tell the system what type, version, address, database 
name (header block name) and 
filename that instrument should 
have. 

1. Assuming that Project 
Organiser has 
remained open, 
expand the Networks 
folder. 

2. Open the LIN Network 
folder. 

3. Create a LIN 
Instrument folder by 
launching the New 
Instrument wizard. 
File > New Instrument 

 Alternatively, the folder can be launched by pressing . 
Each Instrument corresponds to a physical instrument on the associated network. 

4. This initiates the New Instrument Wizard. After an appropriate Instrument name has been entered, it 
offers the choice of hardware parameters, i.e. type, and version, and Strategy parameters. 

Note:  To simplify the identification of an Instrument, it is recommended that a <Instrument 
Type>_<Node number> convention, e.g. T2750_01 be used. 

 A New Instrument folder can also be created from within the LINtools Engineering Studio application 
for either an existing Network or a new Network, in an existing Project or a New Project. The 
Instrument folder contains an Instrument Database file (.dbf), that includes a default range of LIN 
Diagnostic function blocks. 

 Each block is named automatically, and the associated Tagnames are included in the Tag view. 

5. Follow the instructions shown on each page of the wizard. 

Press the ‘Finish’ button to launch the Build process. This may take a while to create the Instrument folder. 
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6.1 CLONING AN INSTRUMENT 
LIN Instrument folders, including all sub-networks and instruments can be created in Project Organiser from an 
existing ‘Live’ Plant/system network using the Clone Network wizard. 

Note:  Entire Network folders can also be copied from an existing ‘Live’ plant/system using the Clone 
Network Wizard. 

1. Assuming that Project Organiser has remained open, select the Networks folder. 

2. Clone an existing LIN Instrument by launching the Clone Network wizard. Launched by pressing . 

 Each LIN Instrument corresponds to a physical instrument in the system. 

3. In the Clone Network wizard, locate and open the Network containing the required LIN Instrument. 

 The wizard copies the requested files contained in the ‘Live’ Instrument to the Project Organiser 
Instrument folder. However, the Instrument Database file (.dbf), including the LIN function blocks are 
always copied, and the associated Tagnames added to the Tag view. 

Each block is named automatically, and the associated Tagnames included in the Tag view. 
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6.2 CHANGING LIN INSTRUMENT PROPERTIES 
The LIN Instrument folder name and Instrument Version Properties can be changed, but the latter requires some 
additional editing. 

6.2.1 Changing a LIN Instrument folder name 

A LIN Instrument folder name can be changed simply by replacing the icon name. The build process will 
automatically understand that the name has changed. 

6.2.2 Updating a LIN Instrument Version 

A LIN Instrument Version can be updated to a later version by opening the Instrument database file (.dbf), 
deleting the Header Block, and then creating a new Header Block of the correct version, all within LINtools 
Engineering Studio. The Instrument Version must also be changed in the Instrument Properties (See below). 

CAUTION 

These instructions cause the T640, T100, T102, and T103 Instruments to lose all I/O allocations 
because the site/channels are tied into the Header Block. 

 

6.2.3 Changing a LIN Instrument properties 

1. Select the LIN Instrument icon to reveal the context menu. 

2. Select Properties. This shows the LIN Instrument tab. 

3. Change the appropriate fields as required. 

4. Close the Properties window. 
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6.3 MOVING BLOCKS BETWEEN LIN INSTRUMENTS 

Note:  This is not the same as caching blocks. 

If a LIN Block is to be moved between LIN Instruments, failure to follow the instructions below may result in the 
creation of a new Tag in the Project database. This would have a Tagname with an ‘_1’ suffix because the Build 
operation processes the target instrument before the source instrument. As it had not deleted the source block, it 
could not create a new Tag with the same name, so it must create a new Tag with a different name, hence the 
‘_1’ suffix. 

1. Delete the block from the source instrument and Build it. This will detach the Tag in the Project 
database. 

2. Add the block to the target instrument and Build it. The Build will see that there is a new block and a 
detached Tag and will match them up. 

Notes: 
1. When updating the Project database ensure that all Build operations are carried out on the LIN 
Network containing the changes. 
2. For full instructions refer to the Frequently Asked Questions. 

 

WARNING 

If there are Field Tags attached to Block Tags, deleting the Block and building the Instrument will 
result in the disconnection of all Field Tags from that Block as the Block no longer exists. 
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7 CREATE MODBUS / PROFIBUS NETWORK FOLDERS 
The MODBUS or PROFIBUS Network folders are created to store all the files and subfolders related to each 
network in the Project and to control the Online Monitoring and Download operations. 

1. Assuming that Project Organiser has remained open, select the Instrument to which the MODBUS or 
PROFIBUS Network is connected. 

2. Create a MODBUS or PROFIBUS Network folder by launching the New Network wizard (File > New 
Network). 

 Each MODBUS or PROFIBUS network corresponds to a physical network in the system. 

 

 

 

 

 

 

 

 

 

 

3. This initiates the New Network Wizard. After an appropriate Network name has been entered, it offers 
the choice of Network Types: 

Network type Description 
MODBUS  Supports communications between T800/ T940 instruments and the 2500I/O system 

with single Wonderware InTouch Operations viewer. 
PROFIBUS PROFIBUS supports communications between T800 or T940 Instruments and the 2500 

I/O system. 

4. Follow the instructions shown on each page of the wizard. 

5. Click on the ‘Finish’ button to launch the Build process. This may take a while to create the Network 
Type folder.  
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7.1 ONLINE MONITORING AND DOWNLOAD USING NETWORK FOLDERS 
The Properties of each MODBUS or PROFIBUS Network folder allow the selection and configuration of an iTools 
OPC port that can be used to download and monitor a 2500 configuration. 

This setting is required only if Downloading and Monitoring of instruments in this Network folder is to be allowed 
from the context menu and File menu of each instrument. 

If this is not configured, the context menu and File menu for the 2500 Instrument folders will have the Download, 
and Monitor options disabled (greyed out). These operations can still be carried out using the iTools Engineering 
Studio, but in this case the user must know which files are needed for the relevant instruments. 

Note:  After the creation or deletion of a Network folder, a Build operation is carried out 
automatically from Project Organiser in order to update the Project database. 

 

7.1.1 Changing an iTools OPC port 

1. Select the MODBUS or PROFIBUS Network 
folder icon to reveal the context menu. 

2. Select Properties. This shows the MODBUS 
Network or PROFIBUS Network tab 

 

 

 

 

 

3. Change the Online Port and Remote Machine 
fields if required. 

 The Ports Setup button can be used to Add, 
Edit or Delete Port Names. 

4. Close the Properties window. 

Note:  A Build operation is not required 
when only the Properties of the Network 
folder are being edited. 
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8  CREATE 2500 INSTRUMENT FOLDERS 
The 2500 Instrument folders store all the 2500 Instrument Clone configuration files related to this Instrument in 
the Network, including the control options for Online Monitoring and Download operations. If the Network folder 
containing the instruments has not been configured for this purpose the options are unavailable (greyed out). 

The Instrument folder ‘Properties’ indicate the type, version and address of the instrument, and which .uic name 
was requested. It does not show what was configured. 

Only one of the following Instrument Versions should be needed: 
2500 (2 Loop 2500) 
2580 (8 Loop 2500) 
25F0 (SYSIO – Fast IOC. No Loops or Toolkit) 

Note:  The T800 has a default Profibus address of 1. The T940 uses default Profibus addresses 2 for 
the primary processor and 1 for the secondary (if installed). Ensure that addresses on the 
communications line are not duplicated. T800 addresses are configured in the Comms Setup screen 
and the T940 in its _SYSTEM.OPT file. 
For Modbus communications, the T940 address (if configured as Modbus Master) MUST always be 
zero. 
Refer to the T94 Process Supervisor and/or the T800 Visual supervisor handbooks, as required. 

1. Assuming that Project Organiser has remained open, expand the LIN Network folder, and the LIN 
Instrument folder. 

2. Open the I/O Network folder. 

3. Create a I/O Instrument folder 
by launching the New Instrument 
wizard (File > New Instrument). 

 Alternatively, the folder can be 

launched by pressing . 

 Each Instrument corresponds to 
a physical instrument on the 
associated network. 

4. This initiates the New Instrument Wizard. After an appropriate Instrument name has been entered, it 
offers the choice of hardware parameters, i.e. type, and version, and Strategy parameters. 

Note:  It is recommended that an <Instrument Type>_<Modbus/Profibus Address> convention (e.g. 
2500_03) be used to simplify instrument identification. 

5. Follow the instructions shown on each page of the wizard. 

6. Press the ‘Finish’ button to launch the Build process. It may take a while to create the Instrument 
folder. 

Notes… 
1. See ‘Create T800/T940 I/O Block’ if Modbus or Profibus Network folders are to be moved or 
deleted. 
2. After an Instrument folder has been created or deleted, a Build operation is initiated 
automatically from Project Organiser to update the Project database. A Full Project Build must be 
used if Operations Servers are used in the Project (Project > Full Project Build). 
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8.1 CHANGING THE PROPERTIES OF 2500 INSTRUMENTS 
The 2500 Instrument name is changed by replacing the icon name. 

The address is changed by amending the Slave Address field in the Properties dialogue and performing a Build. 
Changes to the type and/or to the version reference require a corresponding change using iTools and the 
Updating a 2500 Instrument Version instructions below. 

Note:  See ‘Create T800/T940 I/O Block’ if Modbus or Profibus Network folders are to be moved or 
deleted. 

8.1.1 Changing a 2500 Instrument folder name 

A 2500 Instrument folder name can be changed by replacing the icon name. The following build process 
recognises that the Instrument name has changed and continues, but any instrument folders that have been 
changed to an already existing Instrument folder name will be ignored. 

By offsetting the folder names, the build will process a folder that it can build. This leaves the original folder 
name free. Repeat builds will subsequently Build the instrument folders as required. If two instrument folder 
names must be swapped, an unused name must first be assigned to one Instrument folder so that the build is able 
to process at least one of the Instrument folders. 

8.1.2 Changing an Instrument address 

This ensures that the Instrument Type and Version match the actual Clone File. 

1. Select the I/O Instrument icon. 

2. Select Properties. This shows the I/O 
Instrument tab. 

3. Click Modbus or Profibus Instrument tab. 

4. Edit the appropriate fields as required. 

5. Close the Properties window. 
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8.1.3 Updating a 2500 Instrument Version 

1. Assuming that Project Organiser has remained open, expand the LIN Network folder, the LIN 
Instrument folder and select the I/O Instrument required. 

2. Launch iTools Engineering Studio by pressing the relevant icon, , in the Application toolbar. 

 Start > … > iTools Engineering Studio, where ‘…’ denotes the installation path. 

3. Create a New Clone File that will replace the current 
Clone File by selecting: File > New Clone file. 

 This opens the New Clone file dialog box. 

 

 

4. Click the Instrument Type template tab 
corresponding to the Template required 

5. Locate and select the Instrument Clone file 
Version required. 

6. Press OK to confirm selection. 

 

 

 

 

 

 

 

7. Select File > Load Values from File from the 
‘Untitled’ Clone File that appears in the iTools 
window. 

 This opens the browse dialogue box. 
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8. Locate and open the Clone 
file containing the correct 
information. 

 

 

 

 

 

 

 

9. Close the Message Log 
dialogue box that opens. 

 Once loaded, Clone File will 
have been upgraded. 

10. Use File > Save, to save the 
New Clone File. 

 

 

 

11. Select the Clone File to be 
replaced, or enter the name 
of the Clone File in the File 
name field. 

12. Press ‘Save’ to overwrite the 
original Clone File  
Ensure the 2500 Instrument 
folder properties (Type and 
Version) match the actual 
Clone File. 

Note:  (See Changing an 
Instrument address, type 
and/or version reference). 

13. Select ‘Yes’ at the 
confirmation window that 
appears. 

14. Close iTools. 
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9 CONFIGURING 2500 CLONE FILES 
Clone files have a ‘.uic’ extension and are configured using iTools Engineering Studio. 

 Start > All Programs > … > iTools Engineering Studio, where ‘…’ denotes the installation path. 

Set the following configuration options in each clone file: - 

Operator.Comms.Baud Modbus Baud Rate – This must match the Modbus baud rate configured in the 
T800 or T940. 

Operator.System.LveCnf Live Config Mode – This should be enabled to allow online changes to 
parameters, e.g. ranges, invert, alarm limits. 

Operator.System.IONwdg Network Watchdog Timeout – This should be set to 1 second which indicates 
the period before the 2500 takes action if the Modbus/Profibus comms fails. 

Operator.System.NwdAct Network Failure Action – This should be set to Stby (Standby) indicating the 
action the 2500 should take once the Network Watchdog Timeout has expired 

Operator.System.IONrec Network Watchdog Recovery Time – This should be set to 1 second which 
indicates the period before the 2500 takes action if the Modbus/Profibus comms 
recovers 

Analogue Alarms in iTools, map onto the LIN D25_AI Blocks as follows: 
ModuleXX.MODXX.ALMXXA.ALSP_1 = Hi Alarm Limit for Channel 1 
ModuleXX.MODXX.ALMXXA.ALSP_3 = Lo Alarm Limit for Channel 1 
ModuleXX.MODXX.ALMXXA.ALSP_2 = Hi Alarm Limit for Channel 2 
ModuleXX.MODXX.ALMXXA.ALSP_4 = Lo Alarm Limit for Channel 2 
ModuleXX.MODXX.ALMXXA.ALSP_5 = Hi Alarm Limit for Channel 3 
ModuleXX.MODXX.ALMXXA.ALSP_7 = Lo Alarm Limit for Channel 3 
ModuleXX.MODXX.ALMXXA.ALSP_6 = Hi Alarm Limit for Channel 4 
ModuleXX.MODXX.ALMXXA.ALSP_8 = Lo Alarm Limit for Channel 4 
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9.1 CHANGING CLONE FILES 

9.1.1 Changing a 2500 Clone File name 

1. Select the 2500 clone file and replace the file 
name. 

2. Select the 2500 Instrument folder icon. 

3. Select Properties. 

 

 

 

 

 

 

 

 

4. Click the Modbus or Profibus Instrument tab. 

5. Find the DefaultUIC field and change it to match the 
2500 Clone File name. 

6. Close the Properties window. 

 

 

 

 

 

 

 

UPDATE THE PROJECT DATABASE 

1. Select the LIN Instrument folder icon. 

 This is the Instrument containing the new Modbus or 
Profibus Instrument. 

2. Build the LIN Instrument folder using the Build button 
on the Application toolbar so that the Project database 
is updated with the new Properties. 
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CHANGING A 2500 CLONE I/O MODULE LAYOUT 

Note: Refer to iTools Help for more details. 

1. Open the Instrument 
folder. 

2. Open the Clone file. (This 
opens iTools.) 

3. Edit the Clone file as 
required. 

4. Save the changes and exit 
iTools. 
To ensure changes are 
accessible to the Project, 
identical changes MUST be 
made in the IO Manager. 

Note:  See ‘Create 
T800/T940 I/0 Blocks’ 
section. 

 

 

 

 

5. Build the Modbus or Profibus Instrument folder using 
the Build button on the Application toolbar so that any 
mismatches between the Clone File and the IO Manager 
are indicated for correction. 

Note:  To update the Project database, a Build 
operation is done automatically from Project 
Organiser after an instrument folder has been created 
or deleted.  
A Full Project Build must be used if Operations 
Servers are used in the Project (Project > Full Project 
Build). 
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10 BUILDING THE NETWORKS FOLDER 
The Networks folder is created to store all the files and subfolders related to each instrument in each network in 
the Project. The Build process takes the information configured in all the folders under the Networks folder and 
automatically enters it into the Project database. This is used by the project tools available in Project Organiser 
and utilities. 

Note:  It is necessary to Build from the Project folder to the Instrument. For example. it is not 
possible to Build a 2500 Instrument until the Network folder containing it has first been built, and so 
on. 

1. Assuming that Project Organiser has remained open, 
select the Networks folder icon. 

2. Build the Networks folder using the Build button on 
the Application toolbar. 

 

 

 

 

 

 

 

 

Notes:   
1.  To update the Project database, a Build operation is done automatically from Project Organiser 
after an instrument folder has been created or deleted.  
A Full Project Build must be used if Operations Servers are used in the Project (Project > Full Project 
Build). 
2. Building Networks or Instruments may be time consuming if there are lots of I/O Instruments and 
no changes have been made to them. The BuildLcl Utility (available on the Installation CD) allows the 
user to build a LIN Instrument folder without building all the I/O Instruments it contains. The utility 
is to be found in the folder <CD>:\Non Installs\Utilities\BuildLcl. The ‘readme.txt’ file that 
accompanies it should be referred to before the utility is used. 
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11 IMPORTING TAGS (TAG IMPORT/EXPORT) 
The Tag Import/Export Utility provides access to general Tag information for ALL Tags. It allows you to import or 
export Tags via .csv/.txt format file to and from the Project database. Changing the format makes the editing of 
the Tags data easier. 

11.1 EXPORTING ALL TAGS TO A .csv/.txt FORMAT 

Note:  This is also appropriate for producing pro-forma file formats. 

1. Assuming that Project Organiser has remained open, 
select the All Tags icon. 

2. Launch Tag Import/Export utility by pressing the 

relevant icon, , in the Application toolbar. 

3. Select ‘Export Tags’. 

4. Select the required Export type. 

DATA SET 

TagData - All Lists all data items available for 
exporting. 

TagData - Security Areas 
Includes Security Area data 
items. 

TagData - Description & Ranges 
Includes FullDesc, BriefDesc and 
Ranges data items and displays 
selectable data items for 
exporting 

TagData - Scan Rates 
Selects the Scan Rate data items for exporting. 

FILE FORMAT 

Data Only Exports all included data 
items excluding Header data. 

Header Only Exports all included data 
items’ Header data ONLY and 
is used to create pro-forma 
file formats. This includes 
Utility version, Project 
database location, Date and 
Time of creation, and 
Description of the 
information displayed in the exported file. 

Data and Header  
Exports a combination of Data and Header information. 
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DELIMITER 

Comma, Exports information as a .csv 
(Comma) format file opened 
primarily using Excel.  

Tab Exports information as .txt 
(Tab) format file opened 
primarily using Notepad. 

 

5. In the ‘Not Included:’ column, select 
the data items to be exported. 

6. Press  to move the selected 
data items to the ‘Included:’ column. 

 Tagname is always included. All other 
data items are selectable depending 
on the Data Set (TagData – All) 
configuration above. 

   Add to Included column. 

   Return to Not Included 
column. 

   Add ALL to Included column. 

   Return ALL to Not Included column. 

    Move data item up in the order. 

   Move data item down in the order. 

7. Click on the ‘Export’ button to convert to the format specified in the Delimiter field. 

EDIT EXPORTED FILE 

1. Open the file using Notepad, Excel or Access (whichever is relevant to the file). 

2. Add customer information into the corresponding columns. 

3. Save the file as a .txt (Tab) or .csv (Comma) file. 

 



SYSTEM CONFIGURATION USER GUIDE 

HA028314  
Issue 8  Dec 17 Page 33 

11.1.1 Importing Tags from a .csv/.txt format 

This application is of use when a list of LIN or I/O Tags and the configured parameters, e.g. Tagnames, already 
exist as a .csv or .txt file. Once imported the I/O tags can be used in I/O Manager to create the blocks required 
automatically. 

1. Assuming that Project Organiser has remained open, select the All Tags icon. 

2. Launch Tag Import/Export utility by pressing the 

relevant icon, , in the Application toolbar. 

3. Select ‘Import’. 

 

4. Select the Import Type. 

DELIMITER 

Select the file format type .csv (Comma) or .txt (Tab) from 
the drop down. Auto Sense detects the file format for you. 

5. Select the Data Line Validation. 

BLANK FIELDS 

 Skip if Allowed: Ignores any fields without data. 
Skip if Allowed and Issue Warning:  
Displays a warning for any fields without data 
that have been ignored. 
Always Issue Error:  
Displays warnings whenever an error arises. 

ERROR REPORT 

 Show Only First: Displays only the initial error as 
the user is aware that there is more data 
missing. 

 Show All: Displays all errors to indicate where 
data is missing. 

6. Click on the ‘Import’ button. 
A Browse dialogue window 
opens. 

7. Find the file containing the 
relevant Tags. 

8. Click on the ‘Open’ button. 

Note: Ensure that all file 
errors that the import 
encounters are resolved. 
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12 CREATING T800/T940 I/O BLOCKS 
The IO Manager creates I/O Blocks (D25_AI, D25_AO, D25_DI and D25_DO) in the T800/T940 unit that is 
connected to the selected 2500 Instrument, or I/O Blocks (MOD_UIO, AI_UIO, AO_UIO, DI_UIO, DO_UIO and 
FI2_UIO) in the T2550/T2750 in the Networks folder. 

Note:  LINtools Engineering Studio can also be used to configure the I/O of the T2550, T2750, or 
2500 LIN Instrument. 

By default, the IO Manager displays empty slots. I/O Modules must be assigned to each slot according to how the 
clone file is to be configured. If a clone file has already been created and a Build operation of the Instrument has 
been performed, the IO Manager will automatically have been populated with the same Module Types. Assigning 
a Tag to a channel causes a corresponding LIN Block to be created in the LIN database of the LIN Instrument that 
is connected to the selected Instrument in the Networks folder. 

Once I/O Modules have been allocated, further changes in this Editor or the 2500 clone file will result in warnings 
during the Build operation to indicate each mismatch. 

Notes:   
1. Ensure that the clone file information is identical for both the T800/T940 and the 2500. 
2. If the 2500 Instrument folder or the corresponding Network folder is deleted, or if the 2500 
Instrument folder is moved to another instrument folder using Windows Explorer, All the 2500 
Instrument IO Manager configurations are lost. This includes all the LIN Block field values configured 
using the TagEdit and Mass Edit Editors. 
3. This utility is linked to the TagEdit Utility which enables the editing of Tags. 

12.1 USING THE I/O MANAGER 

Note:  These instructions also apply to the T2550 and 
T2750. 

1. Assuming that Project Organiser has remained open, select 
any instrument connected to an I/O Instrument Network. 

2. Launch IO Manager utility by pressing the relevant icon, 

, in the Application toolbar. 

 

 

 

 

3. Open a Display Node (File > Display Node) 
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4. Select the Node (Instrument) Name you require. 

5. Press OK to confirm and open. 

 

 

6. Change the Slot Count (if required) (File > Slot Count). 

 

 

 

 

 

 

7. Select the number of I/O required and press ‘OK’ to confirm 
and display. 

 

 

 

 

 

8. Select the Slot to be edited 
(IO Slot > IO Slot n). The 
drop down displays the 
commands applicable to the 
selected Slot. 

 

 

 

 

9. Pick IO module from 
drop down. 
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10. Pick Termination Unit from drop down. 

 

 

 

 

 

 

11. Assign IO module and 
Termination Unit (IO Slot > 
Assign IO Module / 
Termination Unit) 

 

 

 

 

 

12. Create Tags for IO Module Slot Channels. 

 Alternatively use the Tag Browser Utility to drag 
Tags into the appropriate Slot Channel. 

 

 

 

 

13. Name the New Tag. 
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12.1.1 Editing Instrument IO Module Channel Tags 

1. Select the Channel Allocations Tag. 

2. Edit the Tag. This opens the TagEdit Utility (IO Slot 
> Channel > Edit Tag) 

Note:  Refer to the TagEdit section. 

3. Edit fields as appropriate. 

4. Close to accept the changes to the Channel Tag 
and exit the TagEdit Utility. 

 

 

 

12.1.2 Amending Instrument IO Module Channel Block Name 

1. Select the Channel Allocations Tag. 

2. Select Block Name (IO Slot > Channel > Block 
Name) 

 

 

 

 

 

 

 

 

3. Amend the unique eight-character Block Name as 
appropriate. 

4. Click OK to accept the changes. 

5. Close IO Manager. 
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12.2 ASSIGNING I/O TAGS TO A T2550 OR A T2750 
When a T2550 or T2750 instrument has been opened in IO Manager, Tags that appear in the Tag view can be 
assigned to the appropriate I/O Module simply by dragging the Tag to the I/O Module shown in the Tree view of 
Project Organiser, and dropping it. 

12.2.1 Update the Project database 

Notes:  To update the Project database, a Build operation is done automatically from Project 
Organiser after an instrument folder has been created or deleted.  
A Full Project Build must be used if Operations Servers are used in the Project (Project > Full Project 
Build). 

1. Select the LIN Network folder icon. This is the 
Network containing the new Modbus or Profibus 
Instrument. 

2. Build the LIN Network folder so that the I/O Blocks 
are created in the LIN Instrument. 
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13 CONFIGURING THE PLANT MODEL 
The Plant Model allows Process Cell and Plant Unit structures to be created, and Tags assigned. Control Modules 
(PID, Valves and Motors) can also be created and configured, but these have very simple structures and do not 
include failure modes or other interlocks which must be added in LINtools Engineering Studio. Plant Units are also 
used to create LINtools Engineering Studio Monitor files for I/O Blocks allocated in the IO Manager. 

Note:  It is recommended that LINtools Engineering Studio be used to create, configure or edit 
Control Modules. 

13.1 CREATING A PROCESS CELL 
1. Assuming that Project 

Organiser has remained 
open, select the Plant 
Model folder. 

2. Create a Process Cell 
folder by launching the 
New Process Cell wizard 
(File > New Process Cell). 

 Alternatively, the folder 
can be launched by 

clicking on . 

 Each Process Cell 
corresponds to a physical 
subdivision in the 
plant/system. 

3. The New Process Cell Wizard starts. Follow the instructions shown on each page of the wizard. 

4. Click on the ‘Finish’ button. 

Notes: 

1. ‘Finish’ does not automatically launch the Build process. 

2. Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help File for 
full instructions. 

 

13.2 CONFIGURE A PROCESS CELL 
The Name and Description parameters of each Process Cell can be edited, by selecting the Properties command 
from the context menu to show the Properties dialog. 
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13.3 CREATE A PLANT UNIT 
1. Assuming that Project 

Organiser has remained 
open, select the Plant 
Model folder and 
expand the appropriate 
Process Cell. 

2. Create a Plant Unit 
folder by launching the 
New Plant Unit wizard 
(File > New Plant Unit). 

 Alternatively, the folder 
can be launched by 

clicking on . 

 Each Plant Unit generally 
corresponds to a major processing activity, centred on a major piece of processing equipment in the 
plant/system. 

3. The New Process Cell Wizard starts. Follow the instructions shown on each page of the wizard. 

4. Click on the ‘Finish’ button. 

Notes: 

1. ‘Finish’ does not automatically launch the Build process. 

2. Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help File for 
full instructions. 

13.4 CONFIGURE A PLANT UNIT 
The Name and Description parameters of each Plant Unit can be edited, by selecting the Properties command 
from the context menu to show the Properties dialog. 

13.4.1 Assigning Tags 

It is important to create Process Cells and Plant Units because it offers better organisation of the Tags in the 
Project. When both the instrument and the Plant Unit have been created, Tags in the instrument folder can be 
assigned to a Plant Unit. Any Tag that appears in the Tag view can be assigned to the appropriate Plant Unit 
simply by dragging the Tag to the Plant Unit shown in the Tree view of Project Organiser, and dropping it. 

Note:  Any Tag assigned to a Plant Unit will be included in all instances. For example, if adding PT5-7 
to the TEG_Inlet_Valve Plant Unit, the Tag will also be assigned to the Alarm Group containing the 
TEG_Inlet_Valve Plant Unit. 
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14 CONFIGURING ALARM GROUPS AND ALARM GROUP SETS 
This allows Alarm Groups to be created and individual Tags and groups of Tags already in Plant Units to be 
assigned, for reporting alarms in the Supervisory Computer during run time. 

The Alarm Group Sets allow the user to assign groups of Tags already in Alarm Groups that may also already 
contain Plant Units, for reporting alarms in the Supervisory Computer during run time. 

Notes:   
1. Alarm Group Sets can be assigned to one or more Supervisory Computers to provide a default 
set of alarms. This is achieved by configuring the computer Alarm Views table in Project Organiser. 
Alarm Group Sets can also be assigned at runtime using the appropriate functions in WindowMaker. 
2. LIN Blocks configured with an Alarm Priority 1 do not display Alarm conditions. 

14.1 CREATING AN ALARM GROUP 
1. Assuming that Project Organiser has remained open, select the Alarm Group folder. 

2. Create an Alarm Group folder by 
launching the New Alarm Group 
wizard (File > New Alarm Group, 

or click on  button). 

 Each Alarm Group is a collection 
of Tags that report an alarm, 
using the Alarm Group name to 
show relevant information about 
the Tag initiating the alarm. 

3. The New Process Cell Wizard 
starts. Follow the instructions 
shown on each page of the 
wizard. 

4. Click on the ‘Finish’ button. 

Notes: 

1. ‘Finish’ does not automatically launch the Build process. 

2. Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help File for 
full instructions. 

During the process of creating and configuring Tags and Alarm Groups, the Wonderware Build icon shows  
to indicate that Wonderware InTouch system MUST be updated, and may also require restarting the InTouch 
WindowViewer if currently running. 
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14.2 CONFIGURING AN ALARM GROUP 
The Name, Description and Default Alarm Group parameters of each Alarm Group can be edited, by selecting the 
Properties command from the context menu to show the Properties dialog. 

Note:  Alarm Groups can be used to clarify the location of an alarm. 

Projects that still require Alarm Group configuration automatically contain the Alarm Groups, ‘Unallocated’ and 
‘Default’. The ‘Default’ group is the initial destination for all new Tags. To simplify the configuration of Alarm 
Groups, the name can be changed and/or a different Alarm Group can be defined as the Default. The 
‘Unallocated’ Alarm Group contains all Tags that have yet to be used to display an Alarm condition. 

Note:  If the Default container does not exist, new Tags are not assigned automatically and must 
instead be assigned using ‘copy and paste’, or ‘drag and drop’ techniques. 

14.2.1 Assigning Tags 

It is important to create Alarm Groups because it offers better organisation of the Tags used to display Alarm 
conditions in the Project. When the instrument and the Plant Unit exist, Tags in the instrument folder or the Plant 
Unit can be assigned to Alarm Groups. Any Plant Unit in the Tree view, or Tag that appears in the Tag view can be 
assigned to the appropriate Alarm Groups simply by dragging the Tag to the Alarm Group shown in the Tree view 
of Project Organiser, and dropping it. 

Note:  To avoid duplication of Alarm messages, Tags should be removed from the Default Alarm 
Group if they are also assigned to an Alarm Group, or to a Plant Unit in an Alarm Group created by a 
user. 
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14.3 CREATING AN ALARM GROUP SET 
‘Alarm Group Sets’ allow the user to create groups of existing Alarm Groups, for reporting alarm conditions in a 
specific Supervisory Computer during run time. A set may be chosen to coincide with an existing Process Cell to 
simplify the configuration, as the Alarm Group Set contains Alarm Groups that must be displayed on a specific 
InTouch Supervisory Computer during run-time. 

1. Assuming that Project 
Organiser has remained 
open, select the Alarm 
Group folder. 

2. Create an Alarm Group 
folder by launching the 
New Alarm Group Set 
wizard (File > New 
Alarm Group Set or click 

on  button). 

 Each Alarm Group Set is 
a collection of Alarm 
Groups associated Tags 
that report an alarm on 
a specific InTouch 
Supervisory Computer, 
as defined by the Alarm 
Views folder configured in the ‘Computers’ folder. 

3. The New Process Cell Wizard starts. Follow the instructions shown on each page of the wizard. 

4. Click on the ‘Finish’ button. 

Notes: 

1. ‘Finish’ does not automatically launch the Build process. 

2. Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help File for 
full instructions. 

14.4 CONFIGURING AN ALARM GROUP SET 
The Name and Description parameters of each Alarm Group Set can be edited, by selecting the Properties 
command from the context menu to show the Properties dialog. 

14.4.1 Assigning Tags 

Alarm Groups Sets are created because it offers better organisation of the specific Tags used to display Alarms in 
the Project on a specific InTouch Supervisory Computer. When the Alarm Groups exist, the Tags in the Alarm 
Group, including any Plant Unit and its configured Tags, can be assigned to Alarm Group Sets. Any Alarm Group 
that appears in the Tree view of Project Organiser can be assigned to the appropriate Alarm Group Sets, simply by 
dragging the Alarm Group and dropping it in the relevant Alarm Group Set. 

Note:  If the Alarm Group Sets are not configured, all computers display all alarm conditions raised 
from all Alarm Groups. 
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15 CONFIGURE TAG SECURITY AREAS 
The Tag Security Area allows the user to create Tag Security Areas and to assign individual Tags or groups of Tags, 
including any that already exist in Plant Units, to those areas (i.e. it separates Tags into security specific groups). 

Tag Security Areas are used in the Security Manager Editor to define which groups of Tags users are allowed to 
view and/or edit. 

Note:  Refer to the Security Manager Help File for full instructions about configuring the Security of 
the plant/system. 

15.1 CREATE A TAG SECURITY AREA 
1. Assuming that Project 

Organiser has 
remained open, select 
the Tag Security folder. 

2. Create a Tag Security 
folder by launching the 
New Tag Security Area 
wizard (‘File > New Tag 
Security Area’ or click 

on  button). 

 Each Tag Security Area 
is a collection of Tags 
that allow edits only 
from sources with an 
appropriate Access 
Level. 

3. The New Process Cell Wizard starts. Follow the instructions shown on each page of the wizard. 

4. Click on the ‘Finish’ button. 

Notes: 

1. ‘Finish’ does not automatically launch the Build process. 

2. Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help File for 
full instructions. 

 



SYSTEM CONFIGURATION USER GUIDE 

HA028314  
Issue 8  Dec 17 Page 45 

15.2 CONFIGURING THE TAG SECURITY AREA 
The Name and Description parameters of each Tag Security Area can be edited, by selecting the Properties 
command from the context menu to show the Properties dialog. 

Projects that still require Tag Security Area configuration automatically contain the Tag Security Area, 
‘Unallocated’. This contains all Tags that have yet to be assigned to an area that restricts the editing to a specific 
group of users, defined in the Security Manager. 

15.2.1 Assigning Tags 

It is important to create Tag Security Areas because it offers better organisation of the Tags used to restrict 
editing of specific Tags in the Project. When both the instrument and the Plant Unit exist, Tags in the instrument 
folder or the Plant Unit can be assigned to Tag Security Areas. Any Plant Unit in the Tree view, or Tag that 
appears in the Tag view can be assigned to the appropriate Tag Security Areas simply by dragging the Tag to the 
Tag Security Area shown in the Tree view of Project Organiser, and dropping it. 
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16 CONFIGURING TAG DATA AND ALARMS 
There are four methods of configuring data associated with a Tag: 
TagEdit. 
Tag Import. 
Tag Profile Configurator. 
Mass Edit. 

16.1 TAG EDIT 
TagEdit is the primary interface for configuring and viewing I/O block data. It provides access to all data for a 
single Tag. The TagEdit dialog box is launched from any Tags displayed in the Tag Browser region on the Project 
Organiser. 

16.1.1 Using the TagEdit Utility 

1. Assuming that Project 
Organiser has remained 
open, select the Tag in the 
Tag Browser region to reveal 
the context menu. 

2. Select ‘Edit Tag’ (or double-
click a Tag in a Plant unit) to 
launch the TagEdit dialogue 
showing the pages described 
below. 

3. Edit fields on the following 
tabs as appropriate. 

General: The Tagname can be a maximum of 12 characters. Changing Tagname does not automatically change the 
LIN Block name. Type and Descriptions can also be changed using Tag Import. 

Note:  The Units field in TagEdit is automatically updated by the Build process in LINtools 
Engineering Studio. 

SCADA Ranges (These are Trend Ranges only – engineering ranges have already been 
configured in LINtools or iTools), InTouch FacePlate, Point Display, Home Page can 
also be changed using Tag Import. 

Network The LIN Block name. The LIN Block name can be a maximum of 8 characters. 
Changing the LIN Block name does not automatically change the Tagname. 

LIN Data The LIN Block Fields and Alarms. Changes made here are written to the Project 
database (for I/O) or the LINtools file as appropriate. This tab provides access to live 
data via the servers set up in the Project Organiser, ‘Computers Properties’ 
configuration. 

 Online data comes from the Online Port settings configured in the LIN Network folder 
for the associated LIN Instrument. It is available only if the Online data is selected. The 
first server is used whether it is On or Offline regardless of redundancy. 

IO Data The iTools clone file fields. Changes made here will be written directly to the iTools 
clone file and provides access to live data via the online port configured in the 
Modbus/Profibus Network folder for that 2500 instrument. Online data comes from 
the Online Port settings configured in the Modbus or Profibus Network folder for the 
associated 2500 Instrument. 
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16.1.2 Importing tags 

The Tag Import/Export Utility provides the ability to produce a list of Tags in a .csv/.txt format file, that currently 
exist in the Project database, or use an existing list of Tags in a .csv/.txt format file in the current Project database. 

16.1.3 Tag Profile Configurator 

Notes:  

1.  Refer to the Tag Profile Help File for full instructions about configuring the Security of the 
plant/system. 

2. Before using the 'Tag Profile Configurator' the user should be aware of the changes that are 
involved when editing a 'Tag Profile'. It may be quicker to make the changes using a .csv/.txt format 
file editor after using the Tag Import/Export Utility. 

The Tag Profile Configurator allows the configuration of 'Block Type' and 'Point Type' parameters that together 
are described as a 'Tag Profile'. All edits are made directly on the Project database and an imported 'Tag Profile' is 
automatically saved when the import is complete. 

'Point Type' is used to provide a special point display in Operations Viewer but if there is no special point display 
configured it reverts to that defined by the 'Block Type'. 

CREATE AN TAG PROFILE 

1. Assuming that Project Organiser has 
remained open, select the ‘All Tags’ item. 

2.  Launch Tag Profile Configurator by clicking 

on , in the Application toolbar. 
 

 

 

3. Select the Tag. 

4. Change the 'Block Type' and 
'Point Type' using the relevant 
pulldown. 

Note:  Point Type/Block 
Type combinations can also 
be called up by double-
clicking on a Tag in the Tag 
Browse window. 

5. In the Field column on the 
'Main Display', select and 
double-click the 'Field' that is 
to be edited. 

 A dialogue window appears. 
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6. In the 'Edit Field…' dialogue: 

 if a change to the Access Level is 
required, uncheck the 'Use 
Defaults' check box and select the 
desired level of restriction. 

 if Confirmation is required, 
uncheck the 'Use Defaults' check 
box and select the desired level of 
Confirmation. 

 enter a name for the selected 
Field when using the fixed field 
'FieldName'. 

 enter a comma separated string 
used to override existing 
enumeration's or provide new 
enumerations for a field. 

7. When the 'Tag Profile' is complete, it MUST be assigned to the appropriate Tag(s) by changing the 
'Point Display'. 

16.1.4 Assign a Tag Profile 

1. Click on the 'Point Type' pulldown and select a 'Assign to Tags...'. Alternatively, press the Assign to 
Tags... button on the ToolBar.  A dialogue box 
appears allowing the user to assign point types to 
multiple tags. 

2. Click the appropriate radio buttons to determine the 
tags to which the point type is to be assigned. 

 'Of Block Type...' assigns to all tags in the Tag Browser 
window of that type. 

 'That are highlighted' assigns the point type to all the 
highlighted tags in the Tag Browser window. 

Note: Select the tags in the Tag Browser window 
before selecting the 'Assign to Tags...' option. 

 'All Visible Tags' assigns the point type to all the tags 
in the Tag Browser window (right hand pane).  

Note:  Always Build from the Project folder down to the I/O Instrument Folder, or use the Full 
Project Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help 
File for full instructions. 
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16.2 MASS EDIT 
The Mass Edit Utility provides access to LIN Block Fields and Alarms for performing changes to many LIN Block 
Tags at the same time. Before using the utility, refer to the ‘readme.txt’ file that accompanies it. 

Using the Mass Edit Utility 

1. Assuming that Project Organiser has 
remained open, select the All Tags 
item. 

2. Launch Mass Edit utility by clicking 

on, ,. 

 

 

 

 

3. Set the Range Filters you require. These Filter drop 
down menus restrict the search to within the set 
constraints. 

 The * in each Filter drop down denotes unrestricted 
search boundary. 

 Process Cell: Select a Process Cell to restrict the search to 
within that constraint. Selecting the * enables a Project 
wide search. 

 Plant Unit: Select a Plant Unit from the selected Process 
Cell to restrict the search to within this constraint. 

 LIN Node: Select a LIN Node from the selected Plant Unit 
to restrict the search to within this constraint. The selection of the * enables the selection of any LIN 
Node in the Project. 

 Tag: Enter the Tagname if known. The * operates as a wild character (*M2_01 finds ALL Tags that end 
M2_01. M2_01* finds ALL Tags that start M2_01). 

4. Select the required Item to display drop down menus 
allowing new values to be entered for a specific Field or 
Subfield of a specific Block Type within the restricted 
search constraints. 

 Block Type: Select a Block Type in the Project. 

 Field Name: Select a Field Name from the Block Type fields 
available. 

 Subfield Name: Select a Subfield Name from the Block 
Type. Not ALL fields have Subfields. 

 New Value: Do not select a new value yet. 
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5. Click ‘Refresh’ to display all Tags that are assigned to the Field 
Name or Subfield Name within the search constraints in the 
Main Display. 

 If required, refine the search shown in the Main Display by 
removing the check mark from the Tags which are not to 
change. 

6. Select a value from the New Value drop down. This may be 
either a numeric, condition or a state value depending on the 
selection of the Field or Subfield. 

7. Click Apply to accept the new value. All selected Tags are then updated. 

8. Repeat this process for all other Block Field combinations. 

9. Close Mass Edit (File > Exit). 

 

Note:  Always Build from the Project folder down to the I/O Instrument Folder, or use the Full 
Project Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help 
File for full instructions. 
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17 CONFIGURE CUSTOM LIN CONFIGURATIONS 
Once the I/O has been created, LIN strategies can be created using: 

1. Standard LINtools Engineering Studio database configuration. This uses a one of each of .dbf, .dtf, and 
.grf LIN instrument files. 

2. A Blended LIN instrument database configuration. This uses more than one .dbf, .dtf, and .grf LIN 
instrument file and requires a build list configured using the appropriate LINtools command. 

3. A Blended LIN instrument database configuration and the IO Manager. For T800 and T940 only, this 
uses more than one .dbf, .dtf, and .grf LIN instrument file a build list configured using the appropriate 
LINtools command. 

 LINtools User Layers are combined using the build list (*.ubl). If the build list (*.ubl) was NOT created 
along with the instrument, it can be created at any time when the Use Blended Database option is 
selected. 

Notes: 

1. Blended Databases are recommended for use by LINtools Advanced users only. 
2. LINtools Engineering Studio also supports the configuration of the I/O for LIN based I/O 
Instruments. 
3. Refer to the LIN Blocks Reference Manual and Application & Control Modules Operator Manual 
for full details of individual blocks. 
4. Refer to the T800 Visual Supervisor Tutorial for full details of T800 unique LIN Blocks. Unique 
Eycon LIN Blocks are described in the Eycon Visual Supervisor Tutorial. 
5. Any LIN strategy requiring the use of a build list must NOT contain more than one *.ubl file in 
the LIN Instrument folder as this could cause problems if the incorrect *.ubl file is used during the 
build process. 
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17.1 USING LINTOOLS ENGINEERING STUDIO 
LIN Instrument folders store all the Instrument configuration files related to an Instrument in a Network. These 
Instrument folders include the control options for Online Monitoring (or Online Connect) and Download 
operations. The Instrument folders of some instruments (e.g. T2550 PAC) also support Online Reconfiguration. If 
the Network folder containing the instruments has not been configured for this purpose the options are 
unavailable (greyed out). Refer to the LINtools Engineering Studio Help file for full details. 

Launching the LINtools Engineering Studio 

1. Assuming that Project Organiser has remained open, locate the LIN Instrument. 

2. Select the LIN Instrument folder. 

3. Launch LINtools Engineering Studio by clicking on, , in the Application toolbar. 

Note:  LINtools supports upto 16 character Tagnames, if correctly configured, but is always limited to 
an eight-character LIN Name. 

4. The Get me started wizard appears, if not previously disabled, offering a selection of most commonly 
u
s
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d
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The following shows the files the user might expect to see and use in the different instruments. It is not a 
complete list. 

Note:  Refer to the relevant instrument and software manuals for full details about which files exist. 

17.1.1 T640 Configuration files 

<file>.dbf/dtf/grf LINtools instrument configuration file – Only the .dbf file needs to be downloaded. 
<file>.uqd/uqt/uqg Generic Sequence file (creates the specific sequence). 
<file>.uqm Generic Sequence map file. 
<file>.sdb/sdt/sgx Specific Sequence file – May be created manually or generated from a Generic 

Sequence File. If used, only the .sdb files need to be downloaded to the T640. 
<file>.stx/sto Action code file. If used, only the .sto file needs to be downloaded to the T640. 
<file>.gwf/gwt Modbus file – Used to support communication between the T640 and either Modbus 

Master or Slave devices. If used, the .gwf needs to be downloaded to the T640. 

17.1.2 T940(X) Configuration files 

List.ujd List of the files to be downloaded to the T940(X). 
Base.dbf/dtf/grf LINtools instrument configuration (Contains the Header block and diagnostics). 
<name>.ubl Build list – Add any use layer .dbf files in here. This defines what layers to merge 

together to create the final T940 configuration. 
<layer>.dbf/dtf/grf User Layer. LINtools instrument configuration. You can have up to 16 layers including 

the base layer. Needs to be added to T940_nn.ubl to be included in the output file. 
<file>.uqd/uqt/uqg Generic Sequence file (creates the Specific Sequence). 
<file>.uqm Generic Sequence map file. 
<file>.sdb/sdt/sgx Specific Sequence file – May be created manually or generated from a Generic 

Sequence File. If used, only the .sdb files need to be downloaded to the T940(X). 
<file>.stx/sto Action code file. If used, only the .sto files need to be downloaded to the T940(X). 
<file>.gwf Modbus Gateway file – Used to support TMA (Transparent Modbus Addressing or Talk 

Through) so that you can communicate iTools to the 2500 via the T940(X) Slave port. 
Needs to be downloaded to the T940(X). 

<profile>.uym Modbus profile – For mapping 3rd party Modbus slaves onto DCM blocks. If used, 
needs to be downloaded to the T940(X). 

Note:  Refer to the LIN Block Reference Manual. 

<profile>.uyp Profibus profile – For mapping 3rd party Profibus slaves onto DCM blocks. If used, 
needs to be downloaded to the T940(X). 

Note 
Refer to the LIN Block Reference Manual. 
<instrument>.gsd Profibus file for 3rd party Profibus instruments (supplied by the manufacturer). If used, 

needs to be downloaded to the T940(X). 
<file>.dbf Resultant instrument configuration file (created when you perform a build). Needs to 

be downloaded to the T940(X). 
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17.1.3 Visual supervisor configuration files 

List.ujd List of the files to be downloaded to the T800 or Eycon. 
Base.dbf/dtf/grf LINtools instrument configuration (Contains the Header block and diagnostics). 
<name>.ubl Build list – Add any use layer .dbf files in here. This defines what layers to merge 

together to create the final T800 or Eycon configuration. 
<layer>.dbf/dtf/grf User Layer. LINtools instrument configuration. You can have up to 16 layers including 

the base layer. Needs to be added to <name>.ubl to be included in the output file. 
<file>.uqd/uqt/uqg Generic Sequence file (creates the specific sequence). 
<file>.uqm Generic Sequence map file. 
<file>.sdb/sdt/sgx Specific Sequence file – May be created manually or generated from a Generic 

Sequence File. If used, the .sdb files need to be downloaded to the T800 or Eycon. 
<file>.stx/sto Action code file. If used, the .sto files need to be downloaded to the T800 or Eycon. 
<file>.uxp/ofl User Screen Configuration - The .ofl files need to be downloaded to the T800 or 

Eycon. 
<file>.uys Setpoint Program. If used, needs to be downloaded to T800 or Eycon. 
<file>.gwf Modbus Gateway file – Used to support TMA (Transparent Modbus Addressing (Talk 

Through/TalkThru)) so that you can communicate iTools to the 2500 via the T800 
Modbus Slave port. You need to setup the T800 comms to enable this. If used, needs 
to be downloaded to the T800 or Eycon. 

<profile>.uym Modbus profile – For mapping 3rd party Modbus slaves onto DCM blocks in a T800 
only. If used, needs to be downloaded to the T800. 

Note:  Refer to the LIN Block Reference Manual. 

<profile>.uyp Profibus profile – For mapping 3rd party Profibus slaves onto DCM blocks in a T800 
only. If used, needs to be downloaded to the T800. 

Note:  Refer to the LIN Block Reference Manual. 

<instrument>.gsd Profibus file for 3rd party Profibus instruments (supplied by the manufacturer). If used, 
needs to be downloaded to the T800 or Eycon. 

<file>.dbf Resultant instrument configuration file (created when you perform a build). Needs to 
be downloaded to the T800 or Eycon. 

<file>.uyn Dictionary file. If used, needs to be downloaded to the T800 or Eycon. 
<file>.uyr Recipe file. If used, needs to be downloaded to the T800 or Eycon. 
<file>.uyb Batch file. If used, needs to be downloaded to the T800 or Eycon. 
<file>.uyl User Dictionary (for customisation of menus). If used, needs to be downloaded to 

T800 or Eycon. 
<file>.uyf Report file. If used, needs to be downloaded to the T800 or Eycon. 
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17.1.4 T2550/T2750 Configuration files 

List.ujd List of the files to be downloaded to the Instrument. 
Base.dbf/dtf/grf LINtools instrument configuration (Contains the Header block and diagnostics). 
<name>.ubl Build list – Automatically edited as new layer .dbf files are added in LINtools. This 

defines what layers to merge together to create the final Instrument configuration. 
<layer>.dbf/dtf/grf User Layer. LINtools instrument configuration. You can have up to 16 layers including 

the base layer. Automatically added to the T2550_nn.ubl to be included in the output 
file. 

<file>.uqd/uqt/uqg Generic Sequence file (creates the specific sequence). 
<file>.uqm Generic Sequence map file. 
<file>.sdb/sdt/sgx Specific Sequence file – May be created manually or generated from a Generic 

Sequence File. If used, the .sdb files need to be downloaded to the Instrument. 
<file>.stx/sto Action code file. If used, the .sto files need to be downloaded to the Instrument. 
<file>.uys Setpoint Program. If used, needs to be downloaded to Instrument. 
<file>.gwf/ujg Modbus Gateway file – Used to support TMA (Transparent Modbus Addressing (Talk 

Through/TalkThru)) so that you can communicate iTools to the I/O via the 
T2550/T2750 Modbus Slave port. You need to setup the Instrument comms to enable 
this. If used, needs to be downloaded to the Instrument. 

<file>.dbf Resultant instrument configuration file (created when you perform a build). Needs to 
be downloaded to the Instrument. 
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18 CONFIGURING THE DISTRIBUTED SYSTEM 
The Wizards and Properties page relating to the Computer, allows the user to edit information in the Project 
Database relating to the computer system and its behaviour in different circumstances. 

This is used to define each Computer (server or client) that is to be included in the system. If a computer does 
not appear in the list, it cannot run the Factory Suite Client Applications or LINData Server. 

Most required Distributed System parameters can be edited via the relevant Computer Properties dialog. 

Note:  The Project Configurator is recommended for use by Advanced users only. 

18.1 CREATE DISTRIBUTED SYSTEM COMPUTERS 
1. Assuming that Project 

Organiser has remained 
open, select the 
Computers folder. 

2. Create a Computer folder 
by launching the New 
Computer wizard (File > 
New Computer) 

 Each Computer 
represents a Server or 
Client Computer used in 
plant/system, and defines 
the InTouch Application 
used by this Project. 

 

 

Notes: 

1. The Computer used to create the Project is automatically generated and configured as a Server, 
when the New Project wizard is completed. 

2. If the Computer used to create the Project is not to be included in the Project, it must be 
removed. 

3. The New Process Cell Wizard starts. Follow the instructions shown on each page of the wizard. 

4. Click on the ‘Finish’ button. 

Notes: 

1. ‘Finish’ does not automatically launch the Build process. 

2. Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help File for 
full instructions. 
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18.2 CHANGING COMPUTER PROPERTIES 
The Computer Properties dialogue replaces the following pages configured using the Project Configurator: 
InTouch Application Name, 
Operations Viewer/Server Computers, 
Access Names (automatically created default identification for access to the I/O Servers, the application on the 
Server and the Security User Name. Further Access Names can be created using the Project Configurator) 

1. Assuming that Project 
Organiser has 
remained open, select 
the Computers folder. 

2. Select the Computer 
icon to reveal the 
context menu. 

3. Select Properties. The 
Computer Settings 
page appears. 

4. Edit the appropriate 
fields as required. 

 

 

 

5. Select the Server 
Setting page. 

6. Edit the appropriate 
fields as required. 

 Any two Computers 
can be configured as 
Server Computers 
(one configured as 
the Master), indicated 
by the checkbox; the 
second Server 
Computer being 
defined using the 
Redundant Partner 
field. 

 The Master and Secondary Servers determine the data and alarm source for the client computers. 
Client computers receive data and alarm information from the Master Server. If the Master Server fails 
for any reason, the data and alarm information is transmitted from the Secondary Server. 

7. Close the Properties window. 
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18.3 OPERATIONS SERVERS 

Note:   The following information is for use by Advanced Project engineers only. It is not the 
recommended method of configuring Operations Servers in a Project, and applies only if using the 
Advanced Project Configuration Tool from the Project Organiser. 

This configuration is used to indicate which LINOPC Servers will provide alarms, and to configure the rôle of each 
server as an Alarm Provider. There are four Server configuration options, described below, that may be combined 
to allow multiple server systems. 

SINGLE SERVER CONFIGURATION 

This automatically configures the Server to operate in Hot Standby and the Alarm Provider to get its watchdog 
from COM Port 0. Setting the watchdog to COM Port 0 (zero) stops the Alarm Provider opening the COM port 
and therefore allows other applications, such as iTools, to use the port when required. 

REDUNDANT PAIR CONFIGURATION 

This automatically configures the two Servers to operate in Hot Standby and the watchdog to read Com Port 1. 

Each server stores a time-stamped alarm entry. The alarm is time-stamped by a Visual Supervisor or T940 LIN 
instrument, or by the server clock for other LIN instruments. The time-stamp of an alarm generated by the Visual 
Supervisor or T940 LIN instrument causes an exact duplicate of the alarm in the Alarm History. Whereas the time-
stamp of an alarm generated by other LIN instruments, e.g. T640 and T103, is derived from the server clock, 
causing each server to store a unique entry of the alarm in the Alarm History. 

Note:  The time-stamps of an alarm will be different even if the servers are time synchronised. 

The Alarm History display is designed to filter duplicate alarm entries, i.e. alarms generated by Visual Supervisor 
and T940 LIN instruments. Alarms generated from other LIN instruments appear twice in a Redundant Pair 
configuration because the time-stamp on an alarm from each server is different. To prevent these duplicate alarm 
entries in the Alarm History display, an RS232 serial link (with pins 2 and 3 crossed over) is required between the 
com ports. The choice of serial port is configurable through the tuning dialogue on the Alarm Provider and is 
most conveniently accessed whilst running. The serial link causes only one of the servers to store alarms in the 
Alarm History. If that server fails, the other server takes control. 

To disable the serial link and make it available to other applications, set the Alarm Provider to Hot Standby and 
the Com port to 0 (zero) in the Alarm Provider configuration, as for the Single Server configuration. This option 
would be used for systems including only Visual Supervisor and T940 instruments. 

Because each block cached from an instrument to a server consumes resources in that instrument, a redundant 
pair configured as ‘No Standby’ using the Project Configurator, doubles the amount of resources consumed. 
Ensure each LIN Instrument can support the consumed resources from the communicating servers. Failure to 
ensure this may result in loss of communication to random Blocks in that instrument. 

If resources in a LIN instrument are not available, using the serial link and configuring the Standby Server to 
Standby using the Project Configurator will only cache and generate alarms when the Primary Server fails, hence 
the resources switch from one server to the other in the instrument. 

Note:  If the system contains LIN instruments other than Visual Supervisors and T940s, and the user 
requires the use of an application such as iTools that also uses a COM Port, another COM port card 
must be fitted (if the server has only a single COM port fitted). 
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18.4 CREATING COMPUTER SERVER PORTS 
This defines which port(s) a Server Computer uses to access instruments within a network specified in the 
Networks folder. 

Any Modbus or Profibus networks that are connected to a Visual supervisor or T940 Instruments that have been 
configured with an online port in the Networks folder will appear here. 

1. Assuming that Project Organiser has remained open, select the Computers folder. 

Note 

Any Ports that already exist in the LINOPC Control Panel will be automatically included in the 
Project, when the New Project wizard is completed. 

2. Create a Server Port 
folder by launching 
the New Port wizard 
(File > New Port) 

 Each Port represents 
a single LINOPC 
Server port 
connected to each 
Server Computer. 

3. The New Process 
Cell Wizard starts. 
Follow the 
instructions shown 
on each page of the 
wizard. 

4. Click on the ‘Finish’ 
button. 

Notes: 

1. ‘Finish’ does not automatically launch the Build process. 

2. Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help File for 
full instructions. 
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18.5 CONFIGURING THE COMPUTER ALARM VIEWS FOLDER 
This allows an Alarm Group Set to be selected to indicate the source of an Alarm and an associated Supervisory 
Computer to be chosen to display that alarm. 

The Computer Alarm Views Folder replaces the following pages configured using the Project Configurator: 
Computer Alarm Views 

 

1. Assuming that Project Organiser has remained open, select the 
Alarm Group Sets folder. 

2. Expand this folder to show the Alarm Groups Sets, including 
each configured Alarm Group.  

 Each of these Alarm Group Sets can be added to any Computer 
containing the Alarm Views folder, simply by dragging the 
Alarm Group Set and dropping it in to the relevant Alarm View 
folder. 

 The ‘Default’ group is the initial destination for all new Tags, 
but this can be changed at any time. The ‘Unallocated’ Alarm 
Group contains all Tags that have yet to be configured to 
display an Alarm condition on a specific Computer, but will 
show the alarm condition on all Computers. 

 

 

Notes:  Always Build from the Project folder down to the I/O Instrument Folder, or use the Full 
Project Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help 
File for full instructions. 
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19 USING THE PROJECT CONFIGURATOR 
Note:  The Project Configurator is recommended for use by Advanced users only. 

 

The Project Configurator (ESCONFIG) allows you to edit information in the Project Database relating to the 
computer system and its behaviour in different circumstances. 

Note:  The tables within this Configurator must be configured in the order given. 

 

1. Assuming that Project Organiser has remained open, 
select the Project folder. 

2. Launch Project Configurator by pressing the relevant 

icon, , in the Application toolbar. This opens the 
EurothermSuite Configurator. 

 

 

 

 

 

19.1 SYSTEM CONFIGURATION 
1. Click ‘System 

Configuration’. This opens 
the Computer 
Configuration dialogue 
box. 
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19.1.1 InTouch Application Name 

This is the name used in WindowMaker and the FactorySuite InTouch Application folder that stores the InTouch 
Application files and is located at 

<project name>\FactorySuite\Clients\InTApps\<InTouch Application folder name> 

More than one FactorySuite InTouch Application can be 
defined in a Project allowing different graphics to be run 
on different Computers but based in the same Project. 
This option is available only by editing the ufolder.ini file 
located in the Project folder and changing the Project 
Configurator entry as follows: - 

Project Configurator=ESConfig.exe /OpPDB 
"%1\project.mdb" /MultipleApplications 

1. Open InTouch Application Name (1). 

 

 

 

 

 

2. Configure the InTouch Application Name. 

Add.  Available only if 
multiple applications 
are configured in the 
ufolder.ini file. 

 Delete.  Removes the 
selected InTouch 
Application Name 
from the list. 

 Edit.  Amends the 
InTouch Application 
Name. Change the 
Name and click 
Update Record to 
confirm changes. 

 

 

Note:  A new InTouch Application will be created if the InTouch Application folder does not exist 
when a Build is performed. 

3. Close InTouch Application Name dialogue box. 
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19.1.2 Computers 

This is used to define the server and/or client computers that 
are to exist in the system. If a computer does not appear in the 
list, it will NOT be able to run the Factory Suite Client 
Applications or LINData Server. 

1. Find the Server Computer or Client Computer 
section, and click Computer(2). 
 

 This opens the current list of Computers. 

 

 

 

 

 

 

2. Configure the Computers. 

 Add.  Enter all 
computers that are 
to exist in the 
system. Complete 
the fields as 
appropriate and 
click Add Record. 

 Delete.  Removes 
selected computer 
record from list 
without requesting 
confirmation. 

 Edit. Amends the specifics of the selected computer. 

Computer Name enter the computer to use the selected InTouch Application. 
Description enter a description of the selected computer. 
Overview Name select the Overview Display Block to be shown by InTouch WindowViewer on the 

specified computer. 
InTouch Application Name  

select the required InTouch Application Name as defined in the InTouch Application 
Name table. 

Note:  Available only if multiple applications are configured in the ufolder.ini file. 

3. Click Update Record to confirm changes. 

4. Close Computers dialog box. 
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19.1.3 Servers 

Note:  The following information is for use only by Advanced Project Engineers. It is not the 
recommended method of configuring the Servers in a Project, and applies only if the Advanced 
Project Configuration Tool from the Project Organiser is being used. 

This is used to indicate which LINOPC Servers will provide alarms, and to configure the role of each server as an 
Alarm Provider. There are four Server configuration options, described below, that may be combined to allow 
multiple server systems. 

DISABLED SERVER 

Any server configured as Disabled does not provide alarms. 

SINGLE SERVER 

This configuration requires the server to be configured as No Standby and the Alarm Provider to get its watchdog 
from COM Port 0 (zero). 

The No Standby setting instructs the server to provide alarms only for LIN Nodes configured as Standby Route = 
False in the Server Ports To LIN Nodes table. 

Setting the watchdog to COM Port 0 stops the Alarm Provider opening the COM port thus allowing other 
applications, such as iTools, to use the port when required. 

REDUNDANT PAIR CONFIGURATION 

This configuration requires two servers (both configured as ‘Hot Standby’) and the watchdog to be set to read 
Com Port 1. In the ‘Server Ports To LIN Nodes’ table the Primary Server has LIN Nodes configured as Standby 
Route = False while the Standby Server has LIN Nodes configured as Standby Route = True. 

Each server stores a time-stamped alarm entry. The alarm is time-stamped by the Visual Supervisor or T940 
instrument or by the server clock for other LIN instruments. The time-stamp of an alarm generated by the Visual 
Supervisor or T940 causes a duplicate of the alarm to appear in the Alarm History. The time-stamp of an alarm 
generated by other LIN instruments, derived from the server clock, causes each server to store a unique entry of 
the alarm in the Alarm History. 

Note:  The time-stamps of an alarm are different even if the servers are time synchronised. 

The Alarm History display is designed to filter duplicate alarm entries (i.e. alarms generated by Visual Supervisor 
and T940 LIN instruments). Alarms generated from other LIN instruments appear twice in a Redundant Pair 
configuration because the alarm time-stamp is different for each server. To prevent these duplicate alarm entries 
in the Alarm History display, an RS232 serial link (with pins 2 and 3 crossed) is required between the com ports. 
The choice of serial port is configurable through the tuning dialog on the Alarm Provider and is most 
conveniently accessed when running. The serial link causes only one of the servers to store alarms in the Alarm 
History. If that server fails, the other server takes control. 

To disable the serial link and make it available for other applications, set the Alarm Provider to Hot Standby and 
the Com port to 0 (zero) in the Alarm Provider configuration. This option would be used for systems which 
include only Visual Supervisor and T940 instruments. 

As each block cached from an instrument to a server consumes resources in that instrument, a redundant pair 
configured as No Standby doubles the amount of consumed resources. Ensure each LIN Instrument can support 
the consumed resources from the communicating servers. Failure to do this may result in a ‘random’ loss of 
communication with Blocks in that instrument. 



SYSTEM CONFIGURATION USER GUIDE 

HA028314  
Issue 8  Dec 17 Page 65 

If resources in this LIN instruments are not available, using the serial link and configuring the Standby Server to 
‘Standby’ will cause alarms to be cached and generated only if the Primary Server fails and the resources switch 
from one server to the other in the instrument. 

Note:  If any LIN instrument other than a Visual Supervisor or a T940 is included in the system, and 
another application, (e.g. iTools), that also uses a COM Port is required, another COM port card must 
be fitted (if the server has currently only a single COM port). 

 

1. Find the Server Computer section, and click 
Server Computer (3). This opens the current list 
of Server Computer. 

 

 

 

2. Configure the Server Computers. 

 Add.  Enter selected 
LINData Computer as a 
LINOPC LINData Server 
and select the Alarm 
Provider Mode required. 
Click Add Record. 

 Delete. Removes the 
selected computer 
without confirmation. 

 Edit.  Amends the Server’s 
Alarm Provider Mode 
configuration. 

 

Computer Name (greyed out) select the computer. 
Alarm Provider Mode 

select the role of the server as an Alarm Provider. 
 Disabled, the server will not provide alarms. 
 No Standby, the server ONLY provides alarms for LIN Nodes configured as Standby 

Route = False in the Server Ports to LIN Nodes table (i.e. Primary Server). LIN Nodes 
configured as Standby Route = True in the Server Ports To LIN Nodes table are 
ignored. 

 Standby, the server provides alarms for LIN Nodes configured as Standby Route = 
False in the Server Ports to LIN Nodes table (i.e. Primary Server). It also provides 
alarms for LIN Nodes configured as Standby Route = True in the ‘Server Ports to LIN 
Nodes’ table (i.e. Standby Server). These are ONLY cached and generated if the server 
cannot communicate with another server configured as Standby or Hot Standby via an 
RS232 serial link. If the serial link is not ready, the server always generates these 
alarms. 
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 Hot Standby, the server provides alarms for LIN Nodes configured as Standby Route = 
False in the ‘Server Ports to LIN Nodes’ table (i.e. Primary Server). 
It also provides Summary and Historical alarms for LIN Nodes configured as Standby 
Route = True in the ‘Server Ports to LIN Nodes table’ (i.e. Standby Server). Historical 
alarms are generated only if the server cannot communicate with another server 
configured as Standby or Hot Standby via an RS232 serial link. If the serial link is not 
ready, the server always generates these alarms. 

3. Update Record to confirm changes. 

Note:  See also the ‘Server Ports to LIN Nodes’ Section. 

4. Close Computer Servers dialogue box. 
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19.1.4 Server Ports 

This area configures the port(s) a Server Computer is using to access instruments within a network specified in the 
Networks folder. 

Note:  Any Modbus or Profibus network that is connected to a T940/Visual Supervisor Instrument, 
which has been configured with an online port in the Networks folder, appears here. 

1. Find the Server Computer section, and click 
Server Ports (4). 
This opens the current list of Ports on the 
Server Computers. 

 

 

 

 

 

 

2. Configure the Server Ports. 

 Add. Enter Network, 
Server and Port 
Names. Click Add 
Record. 

 Delete. Removes the 
selected Server 
Computer Port 
records without 
requesting 
confirmation. 

 Edit. Amends selected 
network records. 

 

Network Name The name of the Network that is connected to the Server via the Port name stated. 
Server Name The name of the Server configured in the Servers dialog box. 
Port Name The name of the Port that connects the Network to the Server. This name must match 

the port name(s) configured on the appropriate server via LINOPC or iTools. 

3. Click Update Record to confirm changes. 

4. Close Server Computer Ports dialog box. 
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19.1.5 Access Names 

Access Names associate I/O Servers (such as LINData and VIEW) to InTouch graphical displays or the InTouch 
Tagname dictionary. This makes it easier to copy graphics between applications if the Access Name is not the 
same as that of the computer. To create 3rd party I/O server Access Names, the server applications must be added 
into the Data Server Applications table located in the Project Configuration. 

Note:  Refer to the Project Configuration instructions in this section. 

Each server must have an Access Name that has its own name in the Master Server Comp column and an empty 
Standby Server Comp column. These Access Names are used to monitor the health of LINOPC on those servers. It 
is recommended that, for the sake of clarity, the Access Name is the same as the Server Computer Name. 

REDUNDANT ACCESS NAME 

To provide redundancy for the InTouch graphics, an Access Name that uses both primary and standby server 
computers is required. As the data provider is called LINData, it is common to use the name LINData as a 
redundant Access Name. When a Tag is assigned to an InTouch graphic, this is the Access Name that should be 
used. 

If there is only a single server, a separate Access Name 
can still be created (e.g. an Access Name LINData can 
be created that has the same Master Server Computer 
and blank Standby Server Computer). This provides an 
upgrade path for the addition of a second server in 
the future. 

1. Find the Client Computer section, and click 
Access Names (5).  
This opens the list of current Access Names. 
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2. Configure the Access Names. 

Notes: 

1. To ensure Access Names appear in the InTouch Application, they must also be included in the 
InTouch Access Names table. 

2.  InTouch Alarms can be included in the Alarm banner only if an InTouch Access Name is 
configured in this table. 

  

 

 

 

 

 

 

 

 

 

 

 

Add  Enter Access Name, Master and Standby Server computers, Application and Security User Name. 
Click Add Record. 

Delete  Removes the selected Access Names records without confirmation. 

Edit  Amends Access Name records. 

Add Defaults Automatically creates an Access Name for each server. 

Access Name The name to be used for addressing this data. 
Master Server Comp 
 The name of the Server with the selected FactorySuite Server Application resident. 
Standby Server Comp  

The name of an optional second Server with the selected FactorySuite Server 
Application resident. 

Application select the name of the FactorySuite Server Application. 

Security User Name This has two purposes:  
 LINData Applications, use the Security User Name to check if a write in the form 

AccessName:Tag.Field = value can be performed when written directly from InTouch. 
 3rd party Applications, used as the TOPIC name for that application. 

3 Click Update Record to confirm changes.  

Note:  An Access Name should be added manually for use in the InTouch graphics to prevent the 
graphics having references to specific computer names. 

4. Close Access Names dialog box. 
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19.1.6 Access Names Override 

It may be necessary to force an InTouch node to get its data from a different server or pair of servers rather than 
the servers defined by the default Access Names. This may be the case if for example, two redundant pairs of 
servers (one pair serving five clients and another pair serving three other clients) wanted to use the same InTouch 
graphics (or the same generic Access Name). Since the graphics refer to a single Access Name (LINData), the 
configuration of that redundant Access Name must be overridden on a client by client basis. 

1. Find the Client Computer section, and 
click Access Names Override (6). 

 This opens the list of current Access 
Names that can be overridden. 

2. Configure the Access Names Override. 

 Add. Enter 
Computer and 
Access Name, and 
Master and Standby 
Server Computers. 
Click Add Record. 

 Delete. Removes the 
selected Access 
Names Override 
record without 
confirmation. 

 Edit. Amends Access 
Names Override 
records. 

Computer Name Select the computer name of the Access Name you wish to override. 

Access Name Select the Access Name of the computer you wish to override. 
Master Server Computer 

Select the name of the Master Server. 
Standby Server Computer 

Select the name for the Standby Server. 

3. Click Update Record to confirm changes, then close the ‘Access Names Override’ dialogue box. 
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19.1.7 Server Ports to LIN Nodes 

This is used to configure the loading of data between the ports on each server. If there are two Computer Arcnet 
cards on each server connected to the same ALIN network, there are two routes that the server can use to access 
the instruments connected to it. The user needs to decide how the loading of instruments is to be shared 
between those cards. 

There should be only one primary route (Standby Route = False) for each instrument in this table, assigned to a 
primary server defined under ‘Access Names’. There should be a corresponding entry with Standby Route = True 
for the standby server. This is required when Standby/No Standby Redundant Servers are configured and is used 
for LINOPC and the Alarm Provider. 

Note:  If a LIN Node can be accessed by more than one server, it must be ensured that one server is 
designated as the Standby route and the other is not. 

1. Find the LIN Nodes section, and click Server 
Ports to LIN Nodes (7). This opens the list of 
current paths from Server to LIN Node that 
can be overridden. 

 

 

 

 

 

 

2. Configure the Server Ports To LIN Nodes. 

 This graphic 
illustrates a 
Communicating Pair 
of servers as 
configured in the 
Server Computers 
table. 

 Add. Enter Server 
Computer, Server 
Port, Network and 
LIN Node Name, 
and Standby Route. 
Click Add Record. 

 Delete. Removes the 
selected Server 
Ports to LIN Nodes record without requesting confirmation. 

 Edit. Amends selected Server Port records. 

 Filter. Select categorised routes between the Server Computers and the LIN Nodes for display. 

 Add Defaults. Inserts all combinations of Server Ports to LIN Nodes records. See graphic above. 
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Server Computer Name 
Select the Computer Name derived from the Server Port table. ONLY editable if the 
filter option is set to LIN Nodes below the Network. 

Server Port Name Select the Port Name derived from the Server Port table. ONLY editable if the filter 
option is set to LIN Nodes below the Network. 

Network Name Select the Network Name derived from the Server Port table. This field cannot be 
modified. 

LIN Node Name Select the name of the instrument as displayed in the Network folder. ONLY editable 
if the filter option is set to LIN Nodes below the Server Computer Port or LIN Nodes 
below the Network. 

Standby Route False = Primary Route for instrument to a primary server defined under Access Names. 
True = Standby Route for instrument to a standby server defined under Access 
Names. 

3. Click Update Record to confirm changes. 

DELETING SERVER PORTS TO LIN NODES RECORDS 

After using the Add Defaults 
button to insert all ‘Server 
Ports To LIN Nodes’ records 
the user should be aware 
that each instrument is 
communicating to both 
Primary and Standby Servers 
via both configured cards. 
Only a single route to each 
Server is required, and can 
be defined by deleting the 
unwanted communication 
routes. 

 

This is achieved by selecting 
a duplicated LIN Node 
record, and clicking the 
Delete button to remove 
the selected communication 
routes. 
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4 Close Server Ports to LIN Nodes dialogue box. 
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19.1.8 FactorySuite Applications 

This is used to select one of the three the Wonderware FactorySuite applications required in the Project. This 
information is used to create Access Names specific for those applications to use. 

VIEW The VIEW Application uses Access Names as configured in the Access Names table. 
Recipe For each Access Name configured in the Access Names table, there will be an 

additional Access Name with a post-fix of “_rcp”. The Client Security table (described 
below) can be used to assign a security user for the recipe Access Names that will be 
used when InTouch recipes are downloaded using the InTouch RecipeLoad function. 

Note:  InTouch Recipe downloads (RecipeLoad) require that the items referred to in the recipe be 
active in Operations Viewer or in the InTouch Tagname dictionary. Operations Viewer recipe 
downloads (ZZRecipeload) have no such requirement so if the InTouch RecipeLoad function is not 
used, the Recipe Application is not required in this selection. 

InSQL This has no effect on Access Names and exists for future use. 

1. Find the Client Computer section, and 
click FactorySuite Client (8). This opens the 
list of current FactorySuite Applications 
configured to operate in the Operations 
Viewer. 

 

 

 

2. Configure the FactorySuite Applications. 

 Add. Enter the Factory-Suite  
Application to be run in 
the Operations Viewer 
Application. Click Add 
Record. (This should not 
normally need to 
change.) 

 Edit. Amends the name 
of the Operations 
Viewer Application to 
run in the Operations 
Viewer Application (This 
should not normally 
need to change.) 

 Delete. Removes the 
selected ES (Operations 
Viewer) Application record without requesting confirmation. 

 Add Defaults. Inserts Recipe and Operations Viewer Application Names to the records. 

3. Click Update Record to confirm change, then close FactorySuite Applications dialogue box. 
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19.1.9 Client Security 

This is used to assign a Security User Name to Access Names required by FactorySuite InTouch recipes for using 
the RecipeLoad function. Without a Security User Name assigned to the Access Names used in the recipe, the 
download will fail. This should not be required if the supplied EurothermSuite data entry wizards and quick 
functions are used. 

Like the Security User Name used in the Access Names table, this is where the Security User Name assigned to an 
Access Name can be overridden on a Computer by Computer basis. 

Note:  For 3rd Party Access Names, the SecurityUserName is the Topic part of the DDE connection 
string. This allows the topic to be different for a given AccessName on a given Computer. 

1. Find the Client Computer section, and 
click Client Security (9). This opens the list 
of current Applications running in the 
system and the associated User Id 
configured to operate. 

 

 

 

 

 

 

2. Configure the Client Security. 

 Add. Enter the 
Computer Name, 
FactorySuite 
Application Name and 
Security User Name. 
Click Add Record. 

 Edit. Amends selected 
Client Security records. 

 Delete. Removes the 
selected Client Security 
record without 
requesting 
confirmation. 

Computer Name The name of the computer, as configured in Server Computer or Client Computer 
section, Computer(2), operating the selected FactorySuite Application. 

Application Name Specify the FactorySuite Application you wish to operate at the selected Computer 
Name. 

Security User Name Specify a User Name (configured in Security Manager) required to use the 
FactorySuite Application at the selected Computer Name. 

3. Click Update Record to confirm changes, then close the Client Security dialogue box. 
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19.1.10 InTouch Access Names 

This is used to define which Access Names are created in the InTouch Application and which server alarms (of the 
alarm generating servers) will be displayed in the alarm banner on each FactorySuite Application. 

Note: To ensure Access Names appear in the InTouch Application, they must also be included in the 
InTouch Access Names table described above. 

Note 
Refer to the Access Names instructions in this section. 

1. Find the Client Computer section, and 
click InTouch (10). This opens the list of 
currently configured FactorySuite 
Applications and shows whether Alarms 
generated from server are displayed in 
Operations Viewer Alarm banner. 

 

 

 

2. Configure the InTouch Access Names. 

Only entries in this table will be created in the 
InTouch Application. 

Note: Use the Add Defaults button to update the window with the relevant configured data. 

 Add. Enter the 
Access Name, 
and Alarms 
(True/False). 
Click Add 
Record. 

 Delete.  
Removes the 
selected 
InTouch Access 
Names record 
without 
requesting 
confirmation. 

Edit. Amends selected InTouch Access Names records. 

Add Defaults. Inserts current InTouch Access Names to the records. 

Access Name select the name that FactorySuite Application uses to access the server. 
Alarms True = Alarms generated from server are displayed in Operations Viewer Alarm 

banner, False = Alarms generated from server are not displayed in Operations Viewer 
Alarm banner. 

Click Update Record to confirm changes, then close InTouch Access Names dialogue box. 
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19.1.11 InSQL Access Names 

InSQL does not use Access Names. This table is used to define which instruments should be exported for trending 
by InSQL according to the selected Access Name. 

This is used to define a Computer operating the InSQL Application and the Access Name required for use. It 
generates files required to Trend LIN block fields in Wonderware Industrial SQL server. The files are stored in 

<Project>\FactorySuite\Clients\InSApps\ <computer name> 

The files generated are InTouch Tagname dictionary files that contain all the InSQL Tags corresponding to each 
LIN block that has been selected as InSQL Trended. To observe or edit Trended LIN block type fields, select 

Project Configurator/Project Configuration/TagTrendData 

1. Find the Client Computer section, and click InSQL (11). This opens the list of currently configured 
InSQL Computer Names and associated Access Names. 
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2. Configure the INSQL 
Access Names. 

 Add. Enter the Access 
Name, and Alarms 
(True/False). Click 
Add Record. 

 Delete. Removes the 
selected InSQL Access 
Names record without 
requesting 
confirmation. 

 Edit. Amends selected 
InSQL Access Names 
records. 

 Add Defaults. Inserts current InSQL Access Names to the records. 

 

Computer Name Select the client computer name of the computer that the InSQL Application uses to 
access the server. 

Access Name Select the Access Name of the computer you wish to use to operate InSQL. 

Note:  The Access Name is not used by INSQL. It is only a means of selecting the server for which 
data will be exported. Only data accessible by that server (via Server Ports to LIN Nodes) will be 
exported. 

 

3. Click ‘Update Record’ to confirm changes, then close the InSQL Access Names dialogue box. 
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19.1.12 Computer Alarm Views 

Note:  These parameters are now configured using the Project Organiser, Alarm Groups Sets and 
Alarm Views in the Computers Folder, please refer to the Project Organiser Help File for full 
instructions. 

 

This is used to select an Alarm Group Set to indicate the source of an Alarm, and an associated Supervisory 
Computer for displaying that alarm. 

1. Find the Client Computer section, and click 
Computer Alarm Sets (12). This opens the 
list of current Computer Alarm Views. 

 

 

 

 

 

 

 

 

2. Configure the Computer Alarm Views. 

Add. Creates a Computer 
Alarm View record. 
Select a Computer 
Name. Select an 
Alarm Group Set. 
Click Add Record. 

 Delete. Removes the 
selected Computer 
Alarm View record 
without requesting 
confirmation. 

 Edit. Amends 
selected Computer 
Alarm View record. 

Computer Name
 Select the name of the computer to display alarms occurring in the selected 
Alarm Group Set, see below. 

Alarm Group Set Select the Alarm Group Set to display alarms on the selected computer, see above. 

3. Click Update Record to confirm changes, then close the Computer Alarm View dialogue box. 
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19.2 PROJECT CONFIGURATION 
1. Click Project 

Configuration.  This opens 
the Project Configuration 
dialogue box. 

 

 

 

 

 

 

 

 

 

2. Click Server Applications.  
This opens the Data Server 
Applications dialogue box 
enabling 3rd party I/O 
Server Access Names to be 
created. 

 

 

 

3. Configure Data Server Applications. 

Add.  Enter the name of a 
Server Application used in 
FactorySuite. Click Add 
Record. 

 Edit. Amends selected 
Server Name records. 

 Delete. Removes the 
selected Server Name 
record without requesting 
confirmation. 

 Server Name.  Enter name for the selected Server Application. 

4. Click Update Record to confirm changes, then close the Data Server Applications dialogue box. 

5. Close Project Configuration. 

6. Close Project Configurator. 
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20 CONFIGURING TRENDED TAGS 
Each of the Trended folders is configured simply by populating it with the Tags that are to be used in a Trend. 
Each Trended folder is used to identify the Tags that are to be recorded within either the InSQL Server or the 
InTouch Server. Any Tags can be allocated, but only Tags specifically used for Trend purposes will operate 
correctly. 

1. Assuming that Project Organiser has 
remained open, select the Non-Trended 
Tags Folder to show all Tags that are 
not currently used by either of Servers. 

2. Select the Tag, drag it from the Non-
Trended Tags Folder and drop it in the 
required Server folder. 

 

 

 

 

 

 

 

Notes: 

1. Additional information is available on the Properties dialog for the InSQL Trended Tags folder. 

2.  Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). 

3.  Refer to the Project Organiser Help File for full instructions. 
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21 BUILDING THE InTouch APPLICATION 
To ensure that all relevant information held in the Project database is accessible to the InTouch Application, use 
the Wonderware Build button from the Application toolbar, or the Project > Full Project Build command. This 
automatically builds the entire Project creating the Access Names configured using the Project Configurator (if 
used) 

Project Configurator > System Configuration > InTouch Access Name (11) 

and the InTouch Trended Tags corresponding to Tags as defined in the LIN Block fields configured using the 
Project Configurator (if used) 

Project Configurator > Project Configuration > Ranged Field data 

The build does not delete InTouch Tags, but it does inform the user if any Tags in the InTouch Tagname 
dictionary were not generated on that build. This can be used to determine any Tags that may need to be deleted 
manually. Similarly, the Build does not delete Access Names. Any Access Names that are not required to be 
deleted from InTouch WindowMaker manually. 

Note:  The Build creates all Tags and does not consider your InTouch Tag license limit. If the number 
of Tags exceeds the user’s InTouch Tag license limit, the InTouch Application will fail to open. To 
open the InTouch Application and delete the excess Tags, a bigger license must be obtained (a 
temporary license can be obtained for this operation, if required). 

BUILD THE PROJECT 

1. Assuming that Project Organiser has 
remained open, select the Project 
folder. 

2. Launch the Wonderware Build by 

pressing the relevant icon, , in the 
Application toolbar (Project > Full 
Project Build). The Wonderware build 
button turns green after a successful 
Build process. 

Note:  Ensure InTouch WindowMaker and WindowViewer are not running when building the Project, 
otherwise errors will occur. 
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21.1 InTouch LICENSE 
The InTouch license is required to: 

1. Run InTouch WindowMaker (Development system, DS). 

2. Run InTouch WindowViewer (Development system, DS or Runtime system, RT). 

3. Control the number of InTouch Tags allowed in the InTouch Tagname dictionary. 

The InTouch License Utility is located under 

 Start > Programs > … > License Utility, where ‘…’ denotes the InTouch installation path. 

 

An InTouch Development license is required for any Computer that acts as an InTouch Development Station and 
also to allow such a Computer to act as an InTouch View Station (Operations Server). 

An InTouch Runtime license is required for Computers that act solely as InTouch View Stations (Operations 
Server). 

The InTouch license is available in two sizes: 1000 and 60 000 Tags. These are mapped onto the size of the 
LINOPC license. Licenses up to and including 300 Operations Viewer Blocks include a 1000 Tag InTouch license. 
Licenses above 300 Operations Viewer Blocks include a 60 000 Tag InTouch license. 

To determine the license required, consider 

1. The InTouch Application uses approximately 700 InTouch Tags (this may vary according to the InTouch 
Application version). The remaining 300 Tags are available for use as InTouch Trend Tags. 

2. When a LIN Block Tag is trended using the developer tools, the Project build, automatically creates an 
InTouch supertag for each Trended LIN Block. The supertag accounts for 1 entry in the InTouch Tag 
license. Each Trended field accounts for one additional entry in the InTouch Tag license, for example, a 
Trended PID block, uses four InTouch Tags entries (Supertag – the PID block name, plus one per PV, 
OP, SP). A Trended analogue input block, uses two InTouch Tags entries (Supertag – the Input block 
name, plus one per PV). 

3. A Trended Field Tag, accounts for only one InTouch Tag entry. 

4. If the user’s InTouch Application requires any InTouch Tags for custom logic or other 3rd party I/O 
communications this will require the ‘InTouch Runtime with I/O’ license. 

The number of LIN Blocks that need Trending and the corresponding number of InTouch Tags required to 
achieve this can be estimated using the above points. If the number of InTouch Tags is close to or greater than 
300, a 60 000 InTouch Tag license (LINOPC + InTouch) is required. The minimum InTouch Tag license that 
provides 60 000 InTouch Tag is a 1000 LIN Block LINOPC license. 
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21.1.1 Installing an InTouch License 

Note:  Refer to the License Utility Help File for full instructions. 

Open the InTouch license Utility. 

 Start > Programs > … > License Utility, where ‘…’ denotes the Wonderware installation path. 

This opens the InTouch license wizard. 

Use the Help File for instructions 
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21.1.2 Requesting an Operations Viewer License 

This License (ulicense.ujl) is required to authorise the use of Operations Viewer software. 

1. Open the Operations Viewer license Utility. 

  Start > Programs > … > License Utility, where ‘…’ 
denotes the Wonderware installation path. This opens the 
License wizard. 

2. Select the required License Utility mode. 

 Create New License. Required for new Project. 

 View / Update Current License. Required for 
changing License package request details. 

 Restore License From File. Required for locating and 
restoring an existing license (or backup copy). 

 Create a Temporary License from a File. Required 
for running the system for 72 hours. Created from 
an existing backup license and must be 
acknowledged within five minutes of every hour. 

 

 The ‘View Stats’ button displays the Operations Viewer and OPC system Block usage. 

 Press ‘Project Path’ to view/edit the path for the Default Project. 

3. Press OK to continue. 

4. Observe the PC Code and PC name 
and press ‘Next’ to continue. 
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5. Enter the Company contact and Order 
Number details. And press ‘Next’ to 
continue. 

 

 

 

 

 

 

 

 

6. Choose the required Template 
Package from the drop-down menu. 
Press ‘Next’ to continue. 

 

 

 

 

 

 

 

 

7. Select the maximum number of 
Operations Viewer Blocks the system 
will be required to cache into LINOPC. 
Press ‘Next’ to continue. 
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8. Select the maximum number of OPC Blocks the system will be required to cache into LINOPC, e.g. 
blocks cached from a third-party 
application. 
Press ‘Next’  to continue. 

 

 

 

 

 

 

 

 

9. Select the License Options required. 

Note:  Selecting Elect Records and 
Elect Signature options offer full 
Audit Trail and functionality required 
for 21 CFR Pt 11 compliance. 

 Press ‘Next’ to continue. 

 

 

 

 

 

10 Enter a comment, if desired.  
Press ‘Next’ to continue. 
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11. Important.  
Read the information in this 
dialogue box. 
Press ‘Next’ to continue. 

 

 

 

 

 

 

 

 

 

 

 

12 Select  to 
view and update 
License Package 
options. 

13. Amend Contact 
and Order No. 
details as 
required. 

 Copy License.  
Duplicates 
License details to 
the Computer 
clipboard. 

 Paste License. 
Inserts all copied 
License details. 

 Write Text File.  
Converts License details to a .txt format to request License from the email address supplied. 

 Load Other License.  Enable the selection of the most recent Saved Licenses. 

 Create Backup. Saves a copy of the final License agreement. 

 Save.  Saves all License data. May be used pending a License Code, ready for retrieval later. 

 Cancel.  Ignores all License data included since last save. 
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14. Press  to close the View and Update dialogue 
box. 

15. Press ‘Exit’ to close the License Utility. 
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22 CONFIGURE DISPLAY NAVIGATION 
The Display Navigation is based around Display Blocks as opposed to mimics. A Display Block allows you to assign 
other features along with the mimic name: - 

Security Level Defines the level of security a user requires to view the selected Display Block. This 
corresponds to the Display Access Level Access Rights configured in Security Manager 
(0 to 9999). 

Process Cell Display Defines which display blocks appear in the Process Cell list in Operations Viewer 
providing easier navigation to the main process displays. 

Process Cell Page Defines the display block displayed in Operations Viewer when the Process Cell button 
is selected. 

Alarm History Page Defines the Alarm Group historical alarms displayed in Operations Viewer when the 
Alarm History button is selected. 

Caution 

When using Windows XP Operating System, the Windows Classic Theme must be configured. 
Failure to do so may result in the intermittent malfunction of the Alarm History page in the 
Operations Viewer. To select Windows classic: 
Right-click the Windows Desktop to reveal the context menu, and select ‘Properties’. The Display 
Properties dialogue appears. Click the Theme tab and select Windows Classic from the drop-down 
menu. Press OK to confirm changes. 

 
Trend Page Defines the Trend displayed in Operations Viewer when the Trend button is selected. 

In addition, the Display Block requires the user to define the destination when 
operating the up, down, previous and next navigation in the Operations Viewer. 

Note:  If different navigations are required for different Computers a unique set of Display Blocks 
must be configured for each Computer, including the Overview. 
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22.1 CREATE A DISPLAY BLOCK 

Note:  Display Blocks can also be created from WindowMaker, which is the application used to 
generate the user display, shown via the WindowViewer on the Operations Viewer. 
To create specialised user displays, refer to the WindowMaker help. 

1. Assuming that Project 
Organiser has remained 
open, select the Displays 
folder. 

2. Create a Displays Block 
by launching the New 
Display Block wizard 
(File > New Display 

Block or click on  
button). 

 Each Display Block 
represents a screen 
created using the 
WindowMaker 
Application, and shown 
on a configured Operations Viewer. 

Note:  An ‘Overview’ Display block is automatically generated and configured, when the New Project 
wizard is completed. 

3. The New Display Block Wizard starts - follow the instructions shown on each page of the wizard, then 
press ‘Finish’. 

Notes: 

1. ‘Finish’ does not automatically launch the Build process. 

2. Always Build from the Project folder down to the I/O Instrument Folder, or use the Full Project 
Build in Project Organiser (Project > Full Project Build). Refer to the Project Organiser Help File for 
full instructions. 
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22.2 CONFIGURING THE DISPLAY BLOCK 
1. Edit Display Block properties. 

2. Enter a Security Level value between 0 and 9999. This number is a restriction on access to the Mimic 
specified in the Mimic Name field. Only a Display Access Level (in Security Manager (SecMan)) equal or 
greater than that specified can open the Mimic. 

Note:  Refer to the Security Manager Help File for full instructions about the Security field. 

3. Edit Other Display Properties. 

 From the drop-down menu, select the Process Cell page to be associated with this Display Block. The 
drop-down menu is a list of all Display Blocks indicated as a Process Cell Display by the Process Cell 
Display check box. 

 If applicable, select the Alarm page to be associated with this Display Block from the drop-down menu. 
This menu contains a list of all Alarm Groups created in the Alarm Groups Editor. 

 If applicable, select the Trend page to be associated with this Display Block, from the drop-down menu. 

 If applicable, check the Process Cell check box to indicate the current Display Block is a Process Cell 
Display. 
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22.3 CONFIGURING THE DISPLAY NAVIGATION 
1. Edit Display Navigation properties. 

 From each of the drop-down menus, select the Display Block associated with the Mimic which is to be 
displayed when operating the Up, Down, Previous and Next display navigation buttons. 

Note 
For full instructions refer to information shown alongside each dialog. 

Note:  It is recommended that the Up Arrow block be set to ‘Overview’, to ensure a consistent link 
returning to the Overview Display block. 
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23 CONFIGURING SECURITY 
Security configuration is carried out using Security Manager software (SecManDb.ujx). This is a very powerful tool 
as it controls system wide security features for all InTouch Nodes, Visual Supervisor Instruments and LINData by 
means of a master Security database. The Security database can be deployed manually or automatically and is 
used to restrict user actions, ensuring the system cannot be edited without Authorisation and/or Confirmation. 

A security system is configured by allowing specific User Groups to access certain Security item actions. 

The Security Manager (SecManDb.ujx) is launched via the Tools command in Project Organiser. 

Note:  Refer to the Security Manager Help File for full instructions. 

 

Caution 

The Security Database must be deployed before any configured security parameters can operate. 
If this is not done, the user may be denied access to (be locked out of) an Instrument, possibly 
preventing vital maintenance from taking place. To avoid this ‘lock out’ problem, always deploy the 
Security Database to the relevant Security Items. 

 

DEPLOYING THE SECURITY DATABASE 

1. Assuming that Project Organiser has remained open, 
select the Displays folder. 

2. Launch the Security Manager by pressing the  
button, in the Application toolbar. 

 

 

 

 

 

 

 

3. After entering the required Administrator 
User name, Password and, if appropriate, 
selecting the required level of regulation 
the Security Manager parameters are 
displayed. 
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4. Deploy the Security Database (File > Deploy Security) 

Note:  Both Project Database and Security Database can be deployed using the Deploy button, , 
in the Application toolbar. A red Deploy button indicates databases must be deployed for the 
changes to take effect, a green button indicates that any changes that exist in the databases will not 
affect the Project. Refer to the Project Organiser Help File for full instructions. 

This displays the Deploy Security dialogue 

 Deploy.  Replicates the master 
Security Database to an 
individual Security Item 
destination or group of Security 
Items. 

 Deploy All/Zone.  Replicates the 
master Security Database after 
selecting the destination Security 
Item from the Security Item list 
or after selecting the destination 
Security Items in the Zones drop 
down. Deploy to ALL Security 
items (button reads Deploy All) 
or the Security Items in the zone 
selected from drop down 
(button reads Deploy Zone). 

 Zones drop down.  Select the 
Security Zone containing the 
Security Items that must be 
deployed to before pressing the 
Deploy or Deploy All/Zone 
buttons. 

 Exit.  Press to return to the 
Deploy Security Window. 

5 Enter any applicable information 
required by the Save dialog 
window that appears and Press 
‘OK’ to confirm the destination 
of the deployed Security 
Database. 

Note: A ‘Note’ field allows 
information to be added and 
the ‘Sign’ field allows for the 
input of ‘Electronic 
Signatures’. 
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6. After confirming the destination to the selected Security Items, the Deploy Security dialog window 
reappears. It now shows the attempted reconciliations and downloads to the selected items in the ‘Log’ 
field of the window. 

7. Press EXIT on the Deploy Security dialogue to return to the Security Manager Window. 

8. Press EXIT on the Security Manager Window to return to the Project Organiser. 

 

24 CONFIGURE ALARM HISTORY 
Alarm History is configured using the Alarm Logger Configuration (AlarmLogCfg.exe). This tool controls the 
detection and display of alarms. It allows the logging parameters to be configured, including the Priority Range, 
Timing Parameters and Logging Intervals. 

The Alarm Logger Configuration (AlarmLogCfg.exe) is located along with the other AlarmSuite Tools in the 
Program Files folder. 

EurothermSuite 1.x/2.x (InTouch 7.0/7.11) 

<Drive>\Program Files\FactorySuite\InTouch\AlarmLogCfg.exe 

EurothermSuite 3.x and later (InTouch 8 and InTouch 9) 

<Drive>\Program Files\Wonderware\InTouch\AlarmLogCfg.exe 

CONFIGURE ALARM HISTORY 

Open the Alarm Logger Configuration. 

EurothermSuite 1.x/2.x (InTouch 7/7.11) 

 Start > Program > Wonderware FactorySuite > AlarmSuite > Alarm Logger Configuration 

EurothermSuite 3.x and later (InTouch 8 and InTouch 9) 

 Start > Program > Wonderware > AlarmSuite > Alarm Logger Configuration 

Configure the Filter, Logging, Advanced and dbase tabs appropriately. 

Note:  Refer to the Install and Configure the Alarm History section in the EurothermSuite Installation 
and Setup Guide (HA028188) for full instructions. 
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25 CONFIGURE AlarmSuite 
The AlarmSuite application provides you with a set of components that extend and integrate Wonderware 
FactorySuite through enhanced functionality for the collecting, managing, and the visualising of process alarms 
and events into an SQL database. It also provides a knowledge database that can be used to analyse process and 
machine performance. 

Note: Alarms and events can be visualised and analysed using the set of ActiveX visual components 
supplied with AlarmSuite. These components also allow you to cross-correlate process events with 
historical process data, SPC data, and tracking data. 

In addition to process-related alarms, AlarmSuite can maintain a comprehensive log of operator actions, including 
logon/logoff events and setpoint changes. Custom reports and displays are easily developed using AlarmSuite and 
FactorySuite tools. 

Notes: 

1. InTouch alarms can be automatically stored in Wonderware IndustrialSQL Server (Version 7.1 or 
later) or Microsoft SQL Server (Version 7.0 or later) using the Wonderware AlarmLogger component. 

2. Before using this application ensure that the AlarmSuite Purge and Restore Utilities have been 
added to the Windows  Start menu. 

TO CREATE A SHORTCUT IN THE  START MENU 

1. Open an Explorer window. 

2. Open the AlarmSuite Application folder ( Start >… > AlarmSuite) 

3. Create a New Shortcut by starting the Windows Create Shortcut wizard (File > New > Shortcut) 

4. Use the Browse button or enter the full path name to locate the AlarmSuite Purge Utility (generally to 
be found in the Program Files folder). 

5. Select ‘OK’ to accept the AlarmSuite Purge Utility. Completion is confirmed by pressing the ‘Finish’ 
button. 

6. Repeat these instructions for the AlarmSuite Restore Utility. 
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25.1 AlarmSuite PRINT 
This provides continuous alarm printing from a database, which means that alarms are printed as they are logged. 
Multiple AlarmSuite Print Utilities can be operating at the same time to print (identical or different) alarms to 
multiple printers. 

Note:  The AlarmSuite Purge and Restore Utilities control and manage the Alarm History database; 
they do not affect the AlarmSuite Print Utility. 

The AlarmSuite Print Utility (AlarmSuitePrint.exe) is located along with the other AlarmSuite Tools in the Program 
Files folder. 

For EurothermSuite 1.x/2.x (InTouch 7/7.11) the file is found at: 

<Drive>\Program Files\FactorySuite\InTouch\AlarmSuitePrint.exe 

For EurothermSuite 3.x and later (InTouch 8 and InTouch 9) the file is to be found at: 

<Drive>\Program Files\ Wonderware\InTouch\AlarmSuitePrint.exe 

TO CONFIGURE ALARMSUITE PRINT 

1. Open AlarmSuite Print, then follow the instructions in the AlarmSuite Print Help file. 

For EurothermSuite 1.x/2.x (InTouch 7/7.11), AlarmSuite Print is to be found at: 

 Start > Program > Wonderware FactorySuite > AlarmSuite > AlarmSuite Print 

For EurothermSuite 3.x and later (InTouch 8 and InTouch 9) it is found at: 

 Start > Program > Wonderware > AlarmSuite > AlarmSuite Print 

25.2 AlarmSuite PURGE 
This allows the manual or automatic) to purging and/or archiving of alarms and events that have been collected 
by the Alarm History database. 

Note:  The AlarmSuite Purge and Restore Utilities control and manage the Alarm History database; 
they do not affect the AlarmSuite Print Utility. 

The AlarmSuite Purge Utility (AlarmSuitePurge.exe) is located along with the other AlarmSuite Tools in the 
Program Files folder. 

For EurothermSuite 1.x/2.x (InTouch 7/7.11) the file is found at: 

<Drive>\Program Files\FactorySuite\InTouch\AlarmSuitePurge.exe 

For EurothermSuite Server 3.x and later (InTouch 8 and InTouch 9) the file is to be found at: 

<Drive>\Program Files\ Wonderware\InTouch\AlarmSuitePurge.exe 

TO CONFIGURE ALARMSUITE PURGE 

1. Open AlarmSuite Purge, then follow the instructions in the AlarmSuite Purge Help file. 

For EurothermSuite 1.x/2.x (InTouch 7/7.11), AlarmSuite Purge is to be found at: 

 Start > Program > Wonderware FactorySuite > AlarmSuite > AlarmSuite Purge 

For EurothermSuite 3.x and later (InTouch 8 and InTouch 9) it is found at: 

 Start > Program > Wonderware > AlarmSuite > AlarmSuite Purge 
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25.3 AlarmSuite RESTORE 
This allows the user to take data that has been archived using the AlarmSuite Purge Utility and restore it to a 
specified target database to permit reporting and analysis. Any previously archived alarms/events do not have to 
be restored to the same database from which they were archived. In many cases, it may be more desirable to 
create an “offline” database to be used for restoring archived data. 

Note:  The AlarmSuite Purge and Restore Utilities control and manage the Alarm History database; 
they do not affect the AlarmSuite Print Utility. 

The AlarmSuite Restore Utility (AlarmSuiteRestore.exe) is located along with the other AlarmSuite Tools in the 
Program Files folder. 

For EurothermSuite 1.x/2.x (InTouch 7/7.11) the file is found at: 

<Drive>\Program Files\FactorySuite\InTouch\AlarmSuiteRestore.exe 

For EurothermSuite 3.x and later (InTouch 8 and InTouch 9) the file is to be found at: 

<Drive>\Program Files\ Wonderware\InTouch\AlarmSuiteRestore.exe 

TO CONFIGURE ALARMSUITE PURGE 

1. Open AlarmSuite Restore, then follow the instructions in the AlarmSuite Restore Help file. 

For EurothermSuite 1.x/2.x (InTouch 7/7.11), AlarmSuite Restore is to be found at: 

 Start > Program > Wonderware FactorySuite > AlarmSuite > AlarmSuite Restore 

For EurothermSuite 3.x and later (InTouch 8 and InTouch 9) it is found at: 

 Start > Program > Wonderware > AlarmSuite > AlarmSuite Restore 
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26 DEPLOYING THE PROJECT (DATABASE) 
The Project Database and Security Database are deployed to allow client computers to run the InTouch 
Application from the Development Server (DS). 

Notes:   
1. Systems configured with more than 10 Windows NT workstations (including any office computers 
(or similar)) are supported only by the Windows Server Operating System. 
2. To ensure successful deployment of one or both of the databases and operation of the InTouch 
Application on client computers, the following must be observed.  
a. Each computer must have an active, fully functional, EtherNet connection. Windows sharing will 
not be active if the network is disconnected. 
b. Each computer must have a ‘Shared’ network path to the Project folder that will contain a replica 
Project database. 
c. There must be an identical Administrator login for all computers in the plant/system. 

 

27 OPERATIONS SERVER/VIEWER 
The Operations Server/Viewer allows the User to view various parts of the system from a single location. Project 
Organiser provides a central environment to launch a single instance of the Operations Server/Viewer, by allowing 
the startup of all the relevant applications used by the Operations Viewer. 

Note:  For full instructions refer to the appropriate InTouch Help File located at the default InTouch 
installation path   Start > Programs > … > Books 

27.1 STARTUP OPERATIONS SERVER/VIEWER 
This starts all the appropriate server applications (InTouch WindowViewer, LINData, Historical Data Manager, File 
Reconcile Utility, WonderWare Logger, and Alarm Provider) required to operate with the Operations Server / 
Viewer. In a Distributed system, Operations Server/Viewer will copy the InTouch Application from the 
configuration station to the local Network Application Development (NAD) folder. 

OPERATIONS SERVER/VIEWER STARTUP 

1. Assuming that Project Organiser has 
remained open, select the Project 
folder. 

2. Launch the Operations Server/Viewer, 
including all server applications, e.g. 
WindowViewer, LINData, Alarm 
Provider, AlarmLogger, Historical Data 
Manager, by pressing the Startup 

button, , in the Application 
toolbar. 
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27.2 SHUTDOWN OPERATIONS SERVER/VIEWER 
This shuts down all runtime software components (such as InTouch WindowViewer, LINData, Historical Data 
Manager, File Reconcile Utility, WonderWare Logger and Alarm Provider) currently operating with the Operations 
Server/Viewer. 

27.2.1 Operations Server/Viewer Shutdown  

1. Assuming that Project Organiser has 
remained open, use the <Alt+Tab> key 
to select the Project Organiser. 

2, Terminate the Operations 
Server/Viewer by pressing the 

Shutdown icon, , in the 
Application toolbar. 

 This shuts down all runtime software components. 

Note:  If Project Organiser has been closed, Operations Server/Viewer can be Shutdown using 
About > Shutdown View. (This shuts down only the Operations Server/Viewer.) 

 

ABOUT 
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27.3 CUSTOMISING AN OPERATIONS SERVER/VIEWER 
Each Operations Server/Viewer, using all the appropriate server applications (InTouch WindowViewer, LINData, 
Historical Data Manager, File Reconcile Utility, WonderWare Logger, and Alarm Provider) can be customised by 
editing the Shell Application features. 

Note:  For full instructions refer to the Operations Viewer, Shell Application Internals Manual, Part 
no. HA028882. 

27.4 OPERATIONS SERVER AS A SERVICE 
The Operations Server is the software necessary to ‘serve’ data to run-time applications in the system. This 
includes operations such as communicating with the instrument network, receiving and logging data, and so on.  

A configuration utility allows the user to select ‘High Availability’ (recommended) or ‘Standard’ as the run mode 
for the software. If this selection is changed, the change does not come into effect until the Operations Server is 
restarted. If the Server is already running in ‘High Availability’ mode, the server must be stopped before any 
attempt is made to change to ‘Standard’ mode.  

27.4.1 Standard mode 

In ‘Standard’ mode (the default mode) the Operations Server behaves interactively, presenting the user with a 
series of windows containing buttons, tick boxes, text fields and so on, acting as an interface between the user 
and the software. The Operations Server must be started manually in ‘Standard’ mode, and it stops running when 
the user logs off. 

27.4.2 High Availability mode 

When running ‘High Availability’ mode, the various software processes (LINOPC, LINData, Alarm provider etc.) that 
provide data logging and handling run as a service that is configured to start automatically, as a part of the 
operating system boot procedure, when the PC is powered up. The Server runs, communicating with the 
instrument network, receiving and logging data etc, for as long as the PC is powered, whether the user is logged 
in or not. The Server runs in background, and has no user interface. 

To ensure high availability, the system continuously monitors the health of the Operations Server and restarts it as 
quickly as possible after any problem has been detected. 

Note:  It is recommended that the Operations Server is run in ‘High availability’ mode. 
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27.4.3 Configuration 

The Configuration utility can be started in two ways, via the ‘System Checking’ tool, or via the Start menu. 

SYSTEM CHECKING TOOL 

The System checking tool is normally used when setting up the system for the first time. A ‘Wizard’ in the check 
tool reports the current running mode, and provides a button which, when clicked on, launches the configuration 
utility. 

START MENU 

The configuration utility can also be started from the ‘High Availability Config’ item in the Program Files / 
Eurotherm / Utilities menu. 

Figure 26.4.3 shows the Server mode selection window, with High availability mode selected. This selection 
automatically enables the Password field. 

 

Figure 27.4.3  Server mode window 

PASSWORD 

In ‘High availability’ mode, a Password is required for the EPASYSTEM account that is automatically configured 
when the system is set up using the System Checking tool. The password allows the Operations Server actions (e.g. 
writing/reading files to/from the registry) to be validated against a specific user account whilst the user is logged 
out. The (case sensitive) default password is: EPABN148NN, but this may have been edited during ‘Create Users & 
Groups’ (if for example this default is insufficiently complex for the administering security system), in which case, 
if the user does not know the new password, assistance must be sought from the system administrator. 

Once the password has been entered and the ‘Ok’ button clicked, the password is validated. If the entered 
password is incorrect, a message appears asking the user to enter the correct password. If the entered password is 
correct, the configuration utility exits, and the next time the pc is restarted, the Operations Server starts up in 
High availability mode. 
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27.4.4 Advanced users 

Caution 

It is recommended that the file described below be edited only by users who are confident in what 
they are doing. Incorrect editing can lead to loss of data, loss of communications or other 
undesirable system behaviour. 

 

When Operations Server is started, several different software processes are launched. These provide 
communications with the LIN network, data and alarm logging and visualisation. It is possible to define which 
processes are started by editing a file called fsdeply.cfg. This file can be found in Program Files / Eurotherm / 
ESManager.  

An example of a typical entry is as follows: 

[START,SERVER,INTOUCH] 

!START,C:\Program Files\Wonderware\InTouch\AlarmSuitePurge.exe 

START,LINData.exe 

DELAY,10000 

!MINIMISE,AlarmSuite Purge Utility 

START,CanaryLabsLogger 

START,HistData.exe 

START,AlarmLogger 

DELAY,2000 

START,View 

START,FileRec.exe 

DELAY,2000 

MINIMISE,Historical Data Manager,HistMgr 

MINIMISE,LINData,LINData 

MINIMISE,Eurotherm File Reconcile Utility 

START,AlrmProv.exe 

 

It is possible, by editing this file, to add (remove) processes that the user may (not) wish to run, for example a 
third party OPC client. 
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28 CREATE A MODBUS DATA PROVIDER 
Note:  In this example configuration the following equipment was used 2500 Ethernet configured via 
iTools for address 192.168.111.2 and Modbus address = 2 fitted with an AI2 module in slot 1. 

28.1 Create a new project 
To create a Modbus Data Provider, the first step is to create a new project. Proceed as follows: 

1. Start the Eurotherm Project Wizard to create a new project as described in Section 2. 

2. Choose ‘Modbus I/O with operations (InTouch)’ option. 

 
 

3. Click on the ‘Next’ button and enter the name of the project, for example ‘TEST_MB1’. 

 

4. Click on the ‘Next’ button. 

5. If no Modbus ports have been created previously, the following dialog will be displayed. 
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If a port is already available, the wizard will automatically select this port and prompt for 
confirmation. 

6. The project wizard will complete its task by performing a project build and running the Project 
Organiser. 

28.2 Create a Modbus port via the LinOPC applet 
To use the LinOPC applet, proceed as follows: 

 
1. On the LinOPC applet screen, press the Add Port button on the toolbar. 



SYSTEM CONFIGURATION USER GUIDE 

HA028314  
Issue 8  Dec 17 Page 107 

 

2. Use the drop-down menu to select Modbus. 

 

3. Locate the Master Mode and change its setting to TCP/IP and then press the OK button. The port is 
now ready for use. 

28.3 Completing the Data Provider set-up 
To finish the Data Provider set up, proceed as follows 

1. Navigate to the project and locate the Add Dataprovider.uwd file. 
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2. Press ‘Finish’ to complete the setup. 

3. A folder will be created and named in the format: 

<PC name>_<Port Name> e.g EUROTHER-PC_MODBUS1 

 

4. The folder will contain an empty blended database ready for configuration. 

 

5. Use LINtools to open the base.dbf file and add two D25_AI blocks Channel 1 and Channel 2 for 
diagnostics and add an AMC_DIAG block. Check that the slot and channel number match the 
instrument. 

6. Enter the Instr_No field to the value 1. 
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7. Save and build the database. 

28.4 Map IP address 
To communicate to the instrument we need to map the IP address to the instrument specified as Instr_No  = 1. 

1. Right-click in the folder, select New. 

2. In the list of file options select LIN TCPproperties. 

 

3. This will create a file called New LIN TCP properties.uxm. 

 

4. Rename this file _SYSTEM.UXM. If the Eurotherm software version < 4.5 rename the file NTSE.UXM. 

5. Right-click the file and select open with MdbTools. 
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6. Right-click the file and select open with MdbTools. 

7. Press the Add button to create a new entry and then modify the values as required. 

 

8. Then press ‘OK’. 

9. Check that the file contains some data by opening the file with Notepad. The file contents should look 
like this: 



SYSTEM CONFIGURATION USER GUIDE 

HA028314  
Issue 8  Dec 17 Page 111 

 

 

28.5 Testing the configuration 
To test the configuration, use the diagnostic tools in the LinOPC applet to view the NTSE database. 

 
1. When prompted enable the diagnostics and select Custom. 

 

2. Press the Configure button. 
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3. Select the Port diagnostics below Modbus1 in the tree – check that the ‘Show Console’ option is set to 
‘On’. 

 

4. Press OK when done. 

5. Run the database by starting the LinData process. With the diagnostic console enabled the following 
window will be displayed: 

 

6. Cursor down to the INSPECT option, the console will display the blocks in the database. 
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7. Select the AMCDIAG block and press ‘Enter’ on the keyboard. 

8. The console will display the block details if the block is communicating with the instrument. 

Note: The fields L_Req and L_Resp should be approximately the same. 
Field Items such as L_LkTim0, L_LkErrs should not be changing value. 

 

 
 

28.6 Workaround for PAC8 Installations 
If PAC8 has been installed, the following workaround can be used to connect to the NSTE database via LINtools, 
previously this was not possible and LinTools would timeout attempting to connect. 

1. Navigate to ProgramData\Eurotherm\PAC\LIN\Ports. 

2. Click on the port folder (Portx where x=1-4) that applies to the Modbus port. 

3. Edit the Network.unh file and add the following two lines to the bottom of the file. 

[LIN] 
Node=1 
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4. To confirm the change – double click the NTSE.dbf to run LINtools. 

5. Press the blue connect button. 

 

6. Once connected, select the AMCDIAG block. 
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7. As with the console window if communication is good the L_Req and L_Resp should be approximately 
the same value. 

Note: The change to the Network.unh file has not been consolidated into the release. If the port 
configuration is changed via the LINOpc applet the modification will be lost. 
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